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Theme 1: "'Standard software. Text editor Microsoft Word. Create, format and
save the document to address the health problems **

1. Scientific and methodological support of the theme:

Automated Information Technology (AIT) text processing - one of the basic
information technology. Virtually every medical specialist meets with the need to
prepare those or other text documents (certificates, memos, reports, articles, letters,
promotional materials, etc.). From the correctness of the documents and their design
depends largely on the activities of any modern organization. The appearance and
layout, along with the contents of the documents can tell a lot about the organization.
They are a kind of measure of organization of information culture forming its image.
Therefore, it is extremely important to fully own text information processing
technology. The ability to issue the document in accordance with the demands placed
on them is one of the criteria for expert assessment in any area. Efficient processing
of textual information in MSWord Editor assumes knowledge of the basic rules of
registration of the document text. These rules are well-established standards of
business paperwork style. This standards such as: padding fields, point size, line
spacing, choosing a size for headings and body text, etc.

2. Brief theory:
1. Interface elements word processor window.

All the programs that are included in Microsoft Office package, have a similar
interface. All programs have a working area, toolbar, main menu, the task pane.




1.1. The title bar and the Quick Access Toolbar

The title bar at the top of Microsoft Word window. It shows the name of the
program, it displays the name of the current file. If the document you are working on,
Is not saved, Documentl inscription (the serial number can be different) will be

displayed instead of the file name. This is the name of Microsoft Word by default
gives the created files.

When creating a new document in Microsoft Word, it is better to keep it well
and give it a name.

The title bar also provides access to the menu.

Nokymentl - Microsoft Word
5 BOCCTAHOEMTE
Paccuinkn PelieHINpoBaHue Bung MepEMecTHTS

=

= Pazmep
B

=
= 4| T AaB _  CeEpHYTE |

=

flce| L

| [[I'r os 0 PazeephyTe

=

4
n

¥ 3akpoiTh Alt+F4

This menu appears when you right-click on the title bar. With this menu
command, you can move a window, resize it and, as you already know, close the
program. Consider the team more.

» Restore - turns the document window if it is maximized.

* Move - command is available only if the program window is not maximized.

When you select this command, the pointer changes the shape, and then you can
move the window using the cursor keys (arrows)

» Size - the command is only available if the program window is not
maximized.

* Close - minimizes the program window on the taskbar. Again, call the Word
window, you can click on the button of the program on the taskbar.
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Pic. Word button on the taskbar

* Open - command is only available if the program window is not maximized.
This command deploys Microsoft Word window to full screen.

* Close - this team is already familiar to you. It is used to close the program and
the completion of its work.

Also manage the application window, you can use the window control buttons.



Pic. the window control buttons

In Word 2010, a new interface element - Quick Access Toolbar, which is
located on the left side of the title bar.

oo\ 9- )+
-

Faasnan EBcraska
Pic. Quick Access Toolbar

By default, the Quick Access Toolbar handed three teams: the preservation of
the document, cancellation and refund action. You can configure this panel: add or
remove a command. To do this, click Customize Quick Access Toolbar located on
the right side panel.
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Pic. Setup Menu Quick Access Toolbar

1.2. Office button

This menu contains the basic commands for working with files:.. Creating,
opening, saving, closing a document, printing and its settings, etc. To the left of the
names of some teams have an arrow when the mouse pointer on a command, it
appears the sub-menu.
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Pic. Printing submenu commands

In the menu, the Office button is also a list of documents that were opened last.
To open such a file, you just need to click the mouse button on its name in the list. If
you move the pointer to the name of the file, you will see a tooltip with information
about the file's location.
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Pic. The list of recent files

The Office button menu also contains the button Word Options, and already
familiar to you from the Word Out.

When you click the Word Options button, the text editor settings.
1.3. Tape

Tape - an interface element, which replaced the toolbars of previous versions.
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The tabs are located groups of buttons with different icons that provide quick
access to program commands. On one tab there are groups that let you perform
similar command. For example, to group pages is the Insert tab, Tables, Illustrations,
Header and Footer, symbols, and so on. E., Allowing to insert the corresponding

elements in a Word document.
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Pic. Tabs and Ribbon group
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When you select some elements (.. Illustrations, formulas, tables, etc.) on the
tape there are additional tabs - context. They contain special tools to work with these
elements. For example, the allocation pattern appears tab Picture Tools — format,

which includes the tools to change the size, brightness, contrast,

shape, borders

illustration for specifying effects (for example, a drop shadow pattern) frames,

determining the position in the text, and so on .
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Pic. Contextual tab that appears when working with drawings

1.4. Scroll bars

The scroll bars (vertical and horizontal) are used to move the contents of the
document.

1.5. Ruler

At the top of the stage have a horizontal line, and the left side - the vertical.
You can use it to navigate to the text box to change the size and margins of the
document.
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At the bottom of the window is a status bar.

Tekywas Craructuka H3bik
CTpaHiua OokKymeHTa OOKYMEHTA

. demlua'luﬂ Yucno cnos: 1 080 i \9 m‘ccxuﬁ I _] .“]_.1': ‘:‘ t:J L; l;j n'J

\ | i . | =t | |

Konwyectso Mpoeepka Pexumbl MacwTab
CTpaHWL opgorpadcpum npocmoTpa OOKYMEeHTa

B OOKYMEHTE AOKYMEHTa

Pic. Status bar

Each element of the status bar is a button:
Page shows the number of pages and the current page number.

Document Statistics shows the number of pages, words, characters, paragraphs,
and lines.

Spell checking reports the document contains errors.
Language of the document defines the language for checking spelling.

View Modes provide the ability to view a document before printing the
document in read-only mode as a web document, etc.

Document Scale Zooms in or out of the working area.
2. Entering and editing text

The program window is a blank sheet on which the text is typed by keyboard
input.

2.1. Text selection

To perform many editing operations (copy, move, delete, and so on. D.) You
must first select the desired portion of text. To highlight text used as a mouse and
keyboard.

In addition to the mouse to highlight text fragments often use a keyboard.
Move the cursor to the desired location while holding down the Shift key, you can
select text with the mouse or use the arrow keys.

In addition to the above in Word, there are many ways to select different parts
of the text:

« word - double click the mouse button:;



» suggestions - click on any of its word while pressing Ctrl,
* one line - move the mouse pointer to the left of the page field and click once;

» several parts of the text - press and hold down the Ctrl key while selecting
with the mouse.

2.2. Basic Editing Commands

The basic editing commands are Cut, Copy and Paste. Normally, when editing
the commands in the following order: Copy or Cut — Paste — Paste.

With these commands, you can move the parts of the text, quickly make copies
of a document, and so on. D. Before you copy or move the text, it is required to
allocate to show the program with which site you want to perform the operation.

Copy or move text in several ways:

* using the buttons tab Clipboard group on the Home ribbon;
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* the context menu that appears when you click in the text, right-click;
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Pic. Commands Cut, Copy, Paste from the context menu

* keyboard shortcut: Ctrl + X - to cut; Ctrl + C - Copy; Ctrl +V - paste.



THE MAIN OPERATION WHITH DOCUMENTS

document

. keyboard
Operation Sﬁ/ortcu ¢ Call
Creating a new document Ctrl+N Office - CREATE
Opening an existing document Ctrl+O Office > OPEN
Ctrl+F12

Saving a document Shift+F12 | Office >SAVE
Save the document under a Office - SAVE HOW
different name
The conclusion of the Ctrl+P Office —» PRINT
document to the printer (print)
Pr_evi_ew the document before Ctrl+E2 Office — Preview the document
printing
Check the spelling of the F7 Reviewing —Spelling

definition
Page Setup (printed sheet)

Page layout — Page settings ...

3. Original text formatting

Word contains a lot of formatting tools, with which you can significantly
improve the appearance of documents on screen and in print. Validity of the
documents will facilitate the visual perception, and properly selected portions of text

will indicate on what you need to focus.

3.1. Font Settings

Formatting is carried out most frequently by changing font attributes. It has

various attributes: font style (bold, italic, underline), the size (size), and Headset.

Parameters text decoration, which are relevant to the font, assembled on the
Home tab of the ribbon and in the Font dialog box. To open it, do one of the

following:

* Click on the button, which is located in the Font group of the Home tab on

the Ribbon;
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Pic. Opening the window Font button

« press the key combination Ctrl + D;

e click Font from the shortcut menu.
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Pic. Selection in the context menu of the Font menu

Font dialog box has two tabs: Font and Spacing. Consider the available
options.

 Use the Font tab, you can choose the color of the text, change the font style
(regular, italic, bold, bold italic), set the size and color of the character.
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» Spacing tab helps to determine the distance between the text characters.
Depending on the option selected font can be compacted, and the usual sparse. On the

same tab you can select the scale at which symbols become wider or narrower (if
more than 100%, the text is stretched, if less - compressed).
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3.2. Font group of the Home tab

Change the font settings is possible, using not only the Font tab of the same
name of the window. In many cases, much more convenient to use tools Font group
of the Home tab on the Ribbon.
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Pic. Font group of the Home tab

Use the Font group of buttons you can perform all the basic steps for
registration of the text:

» change the font style - make bold, italic, underline, strikethrough.

If you click on the triangle to the right of the Underline button, you will see a
list from which you can choose the type, thickness and color of the underline line.
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Pic. The list of options underscore line
* Create sub- *: and superscripts;
« modify register 4a”
« highlight text * ~, and set the font color £ "

If you click on the triangle to the right of the button, you will see a list of
available colors.
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* Set the headset (type) font. The most common headset Times New Roman,
Arial, Courier New;
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* Select a font (size) font;
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« increase A or decrease A" the font size in increments of one point;

« clean the format, that is, clean design >

3.3. Paragraph Formatting

In the previous section, you were introduced to character formatting tools. In
Word there are also special features for text formatting within paragraphs: alignment,
line spacing and margins. Formatting Operations paragraphs, as well as with other
parts of the text are made only after prior isolation.

3.4. Alignment

Alignment of text on the page - one of the most important formatting
operations. Using alignment, you can, for example, put the header text in the middle
of the page, and the signature at the end of the letter - to the right. Many novice users
for such tasks repeatedly press the space bar, but with the help of alignment to control
the placement of text on the page is easier, faster and more correct.

Align all text or individual paragraphs can be changed in several ways:

* using the corresponding buttons Paragraph group of the Home tab on the
ribbon:

- Align Left

- In the center

- Align Right

- Justify

 Alignment using a list of the Paragraph dialog.
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Pic. Paragraph dialog box, a list of Alignment

This window can be opened by clicking on the button to open windows in the
Paragraph group on the Home tab, or by running the tape Paragraph pop-up menu
that appears when you right-click anywhere in a paragraph.

Pic. Paragraph window Call Button
3.5. Hyphenation

When aligning the width of the narrow blocks of text (eg, speaker) spaces
between words may be too large. To avoid this, you need to hyphenate follows.

1. Click the Layout ribbon page. In the Page Setup group, click
Hyphenation.
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2. Vypolnite in Auto menu command. As a result, transfers will be placed
automatically in the entire document.

3. If necessary, adjust the hyphenation settings in hyphenation, which
opens the command menu options hyphenation hyphenation button.
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Pic. Dialog hyphenation

3.6. Interval

Line Spacing - the vertical distance between lines of text within a paragraph.
By default, Microsoft Word uses single line spacing. However, depending on the type
of document can be changed.

To change the interval, do the following.

1. Open a window Paragraph by clicking on the appropriate button Paragraph
group, and then click the Indents and Spacing tab.

2. Select an option in the list of interline interval.
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Pic. The interval in the Paragraph dialog box

The most used intervals can be changed without causing the Paragraph
window. To do this, you can use the Line Spacing button in the Paragraph group of
the Home tab on the Ribbon.
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3.7. Indents and tabs
Offset - the distance between the text and the left or right of the page field.

Adjust indentation can be manually using the horizontal ruler.

Padding can be divided into three types:
* Left Indent - sets the position of the entire paragraph with respect to the left

margin of the page, use the marker to change it, illustrated in Figure

-1-|- -|-:|-2-
: 3

_
Pic. Marker left indent

» Right Indent - sets the position of the entire paragraph with respect to the
right page margin, to change it, use the marker shown in the figure;

|-15-Cﬁ§15-|-1?-|-

Pic. Right indent marker

* Indent the first line - determines the position of the first line of the paragraph,
to change it, use the marker shown in Figure

|-e:|%-:-3'l:4

|0Tn’.‘|’_\.-'l'l nepeoi f:rp-:ur.m|

Pic. Marker indent the first line

Along the indented projections can be used. Tab moves the text to the left from
the original line of text at the same time it does not apply to the first line of a
paragraph. To install, use the marker Promontory.
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Adjust indentation and projections can not only using the horizontal ruler, but
also in the Paragraph dialog box.

3.8. Text boundaries

To make text with borders, click the arrow button to the right of the type of
border that is in the Paragraph group of the Home tab on the Ribbon and select the
pop-up list of your preferred option. To remove borders, click the arrow button to the
right of the type of border, and select from the menu There is no border.
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3.9. Generating lists

Very often it is necessary to allocate any part of the text visually (for example,
when transferring). In this case, it makes sense to use bullets and numbering. Markers
combine items related one theme. Numbered lists contain items follow one another.
In addition, there are multi-level lists contain a nested lists.

To create a numbered, bulleted and multi-level lists, you can use the buttons
Markers =~ Numbering =~ and Multilevel List “=" in the Paragraph group of
the Home tab on the Ribbon. Simply click on these buttons, you will create a list with
the last selected formatting. If you click on the triangle to the right of the button, you
will open a list with the list of design options.
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Numbered and bulleted lists can also be created using the Bullets and
Numbering command context menu that appears when you right-click on the line
next to the list or the selection of text that you want to issue a list.
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To create the list, do the following.

1. Scroll to the desired portion of text.

2. Right-click and select the context menu or click on the appropriate button in
the Paragraph group of the Home tab on the Ribbon.

3. Click on the desired type of marker.

4. Tabulation of textual information

Tabulation of textual information is a way to offset the text within a paragraph
by using the TAB key.

Pressing TABprivodit to the horizontal displacement of the cursor to input a
certain distance to the right edge of the page. Default distance that moves the
insertion point is fixed. However, it is possible to arbitrarily set the point of the cursor
with the tab called tabulstopami or tab stops.

Tab stops are set for each paragraph or paragraphs of a group using the scale
ruler or the Tabs button in the Paragraph group of the Home tab on the Ribbon. There
are several types of tab stops defined by the alignment of the test method at the point
of the paragraph.

Type of position : : .
TAB Designation Description
. . the text that is entered in this tab stops
with left-aligned =1 | Wil be left-aligned.
on the right edge (4] the text will be aligned at the right edge
the text will be aligned at the center of
Central (] the tab




o when you select the icon in the tab is

with a dash inserted into a vertical bar.

Current view of the tab set click on the button "Type tab stops."

-|'1'?'2'I'3'I'4'I'5'I'B'I'I"'I'S'I'B'I'1EI'I'11'I'12'I'13'I'14'I'15'I'15'
the tvoe of installation position button ]

To create a paragraph of the tab, you must:

1. to click the mouse on the scale bar
2. sign tabulstopa move by dragging to the desired
position on the scale bar.

[x] CUe L2t i A LB h Rt e B e o0 Lhe 1 d2e 1 13 1 dde ) 15 1 16 - ATERNIEN

Marked tabs on the scale bar

Now you can use the TAB key to change the cursor position and placement of
the text information in certain positions tab. To remove individual items tab, drag the
mark tabulstop beyond the scale ruler.

To remove all tab stops paragraph or group of paragraphs, you must:
Select the paragraph or paragraphs group.
1. Call dialogue Paragraph —Tabulation.

2. Click the Delete All button.
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Pic. Tabs dialog box

Tab stops can also be used when creating lined forms where necessary to
underline blank space where you want to enter text by hand.

For the horizontal line of the text field to the page you need to:

1. Enter the text and set tabulstop with right justified: after selecting the
type of the tab click on the scale bar.
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2. Change the settings tab (Paragraph —Tabulation ...):
- In the section of the aggregate select 4 as shown
figure;
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Pic. window Tabs

The dialogue involves the installation tabs manually, if it is known beforehand
the distance from the page margin to the tab stop in centimeters.

Section alignment is designed to set the alignment of the text in the tab. Filler
section allows you to fill the space on the edge of the page or the previous tab stop by
symbol.

- Press the Set button.

After clicking Ok button, we get.
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Pic. Inscription line with a tab



Now, while continuing to test the input in order to carry out horizontal holding
will need only to press the TAB key. So, if you press Enter, enter the test "position™
TAB, you get:
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Pic. Inscription line with a tab

3. The purpose of activity of students in class:
The student should know:
1. The structure of the main window of the text editor MS. Basic operations for
the text.
2. Key shortcuts.
3. How to change the font of text.
4. How to change the parameters of a paragraph.
5. How to set boundaries.
6. The principle of the tool tabulation of textual information.
7. How to create and delete the tab.
8. How to increase or decrease the length of the line using the tabulation

The student should be able to:

1. Possess basic tools for text processing.

2. Leverage the tabulation of textual information tool, to ensure the stability of
supply of textual material in a changing formatting.

3. Create lists.

4. Set the text border.

5. Typing in text editor MSWORD primary formatting for a specified period of
time (15-20 minutes).

4. Learning content:
1. Interface elements word processor window.
1.1. Tape



1.2. Office button
1.3. scroll bars
1.4. ruler

1.5. Status bar

2.

Entering and editing text

2.1. Text selection

2.2. Basic Editing Commands
2.3. Original text formatting
2.4. font Settings

2.5. Font group of the Home tab

3.

Paragraph Formatting

3.1. alignment

3.2. hyphenation

3.3. Interval

3.4. Indents and tabs

3.5. text boundaries

3.6. Generating lists

3.7. multicolumn text

4. Tabulation of textual information

O© 00 NO Ol & WDN B

N

5. The list of questions to test the level of knowledge:

. What is the unit of text data?

. List the main interface elements MS Word window?
. What is the Ribbon?

. What change the font of the text?

. How to change the paragraph?

. What is the style of the document?

. List the basic operations with the text?

. How do | create a list?

. How to draw a horizontal line using the Tabs tool?

6. The list of questions to check the final level of knowledge:

. Describe the process of creating a new document and save it.
. Describe the process of formatting text.
. Describe the paragraph formatting process.



4. Describe the process of creating a horizontal line using the tools tab.
5. The process of creating the list.

6. How to cause a preview mode of document?

7. How do | output the document for printing?

7. Establish document, collect and format the following text, in accordance with
the sample. Casting Time: 20-30 min.

LIST OF SYMBOLS AND TERMS

. CT scan (CT), (CT) - X-ray computed tomography
. MRI (MR, MRI) - Magnetic resonance imaging
. XA - digital subtraction angiography
. RF - digital radiography (eg myelography)
. MRA- magnetic resonance angiography
. CTA - radiopaque computed Angiography

. MR diffusion - a special MRI program based on the ability of the diffusion
process to influence the processes of MR relaxation. It is used for in-depth
study of pathological processes such as violations of cerebral circulation,
inflammatory central nervous system diseases, neoplasms of the central
nervous system.
8. MR and CT perfusion - special methods of CT and MRI, allow to study the
parameters of cerebral blood flow.
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8. Independent work of students:



According to the textbook will learn the basics of creating, editing, and
formatting text files in MS Word 2007 text editor.

9. Hronokarta training session:
1. Organizing the time - 5 minutes.
2. Monitoring of knowledge - 30 min.
3. Analysis of the theme - 20 min.
4. Practical work - 30 minutes.
5. Wrap-up sessions - 10 min.

10. A list of textbooks for the class:
1. AN Stepanov Computer science. Textbook for high schools. 4th izd.g. St.
Petersburg, Peter., 2006;
2. Esaulenko IE, Semenov SN Basics of practical informatics in medicine;
Voronezh, 2005;



Theme 2: ""Standard software. Text editor Microsoft Word. Tables, formulas,
page breaks for solving medical problems **

1. Scientific and methodological support of the theme:
To develop and consolidate the skills to work with tabular data in Word.

A significant portion of the text information compiled information organized in
tables (table information). Organizing information in tabular form provides a way of
presenting information in which information is grouped according to certain
characteristics, and is located in the network structure. The unit of this structure is a
cell.

The cell is a container for placing textual information.

Many new users after the creation of the grid of the table immediately begin to
change the width of columns, and merge and split cells. This is - the wrong approach,
leading to an increase in table creation time. You must first enter the information in
the table header and in its information part, and only then deal with the change in the
width of columns, and the rest of the table formatting.

2. Brief theory:
1. Create a table structure.

A significant portion of the text information compiled information organized in
tables when the information is grouped according to certain characteristics, and is
located in the network structure. The unit of this structure is a cell.

The cell is a container for placing textual information. You can select the
following operations with cells:

1. Entering data into a cell.
2. Editing information in the cell.
3. Remove the information in the cell.

4. Copying and moving information from one cell to another.



5. Copy and delete cells.
6. Consolidation and separation of cells.

7. Format cells.

Table terminology text processing technology is a form of a rectangular lattice
structure consisting of a number of cells containing text information or designed to

contain text information. The number of rows and columns in the table reflect its
dimension.

Working with the table usually begins with its creation. To create a table in
Word 2010, use one of the following methods.

* Click on the Insert tab, in the Tables group, click Table button. the mouse
pointer to select the number of columns and rows. In the document at the point where
the cursor will draw a table with the speC|f|ed parameters
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Pic. Select the number of rows and columns in a table

* On the Table menu button, click Insert Table. In the Insert Table window that
appears, choose the number of columns and rows, and then click OK.
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Pic. Insert Table window
» Use a blank table from the list of rapid tables. The list is in the Table menu
button. To insert a table into the text, just click on its image in the list, then fill in
your data table.
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Pic. List of express tables

Type in your document where you want to insert a table, the signs "+" and "-"
and press Enter. For example, to create a table of three columns, enter + _+ + +,
Please note that such harvesting must necessarily end with a plus, otherwise the table
will not be created.

* Create a table manually using the Draw Table command in the Table menu

button. When you click Draw Table, the pointer changes to the pencil shape 7 First,
create a table shape, and then draw horizontal and vertical lines.



Pic. Create a table, stage 2

v

Pic. Create a table, stage 3

When you draw a table on the tape will be two contextual tabs - Working with
Tables — Designer and the Table — Layout (for details on these tabs, see below).
Use the tab Work tables — constructor can change the type and width of the lines in
the drawing. In addition, using the Eraser tool, you can remove the drawn lines. After
creating the table press the Draw Table tab of the Table Designer — or press the Esc
key.

» Use the command Table Excel Table button, insert a Word document Excel
spreadsheet. In the Word document, Excel spreadsheet cell will be displayed, and Exc
el commands appear on the tape to a spreadsheet. In a cell, you can enter data,
perform operations on them, using Excel capabilities. Then you need to click on the
empty space outside the cells, and the table is inserted into a Word document. In this
case the table will be inserted into a single object. For her editing will need to double-
click on it to Excel team reappeared.
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Pic. Inserting Excel Word document tables

Convert text into a table. The text, which will occupy a single cell, must be
separated from the text, which will take another cell, some delimiter (such as a tab or
indent). Highlight the text, go to the Insert ribbon, click Table, and then click Convert
Table. This will open the corresponding window. Enter in this box the number of
columns (number of rows at the same time will be set automatically), set the delimiter
that was used when typing, and then click OK. The resulting text is converted into a
table.
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Pic. Text converted in table

2. Editing tables
For table editing operations include both actions that can be performed with the
text in the cells, and a table of the elements - the rows, columns, borders. When you
select a table on the tape there are two contextual tabs - Working with Tables —
Designer and the Table Tools Layout — that contain special tools for editing table.



2.1. Edit text in a table

Jobs with the text located inside the table, almost no different from working
with regular text. For data tables, you can install any formatting, use the usual editing
commands. To move between the cells using the Tab key, the cursor keys or mouse.

To delete the text inside a table, select the table and press the Delete key.

The text inside the table, has its own characteristics. For example, it can be set
in any direction as follows.

1. Place the cursor in the cell, the text of which is to change the direction, or
select the desired portion of the table.

2. Click the Table Tools Layout — tape.

3. Press the direction of the text alignment in the group as long as the text does
not take the right direction.
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Pic. Button Text direction

In addition, the text can be aligned in the cell relative to the cell borders: top
left, top center, top right-aligned, centered, left justified, etc. This can be done by a
group Alignment tab buttons Working with Tables — Layout.. tape or command
submenu Align cell context menu that appears when you right-click on the text in the
cell.
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Pic. Buttons to align text in table cells

2.2. Changing the size and position of the table

To edit the spreadsheet using movement and change markers. move marker
appears in the upper left corner of the table when you hover the mouse pointer over
the table, or click on a table. It has the shape of the cross in the frame. If you click on

it and hold the mouse button, draw, the table moves.
+

Pic. Marker moving table



Clicking on the marker move, you can quickly select the entire table.

Marker resize a table appears in the lower right corner when the mouse pointer
Is within the table. If you click on the marker changes the size of the table and pull
some distance, the table will resize. In this case all of the columns and the cell will
change proportionally.

H|
Pic. Marker resize a table

2.3. Selecting a table

To select a row or column of the table, use one of these methods:

 Highlight the desired areas on the table cells, pre-press and hold the left
mouse button;

* Move the pointer to the left margin or the upper border of the column, and
then click the mouse button.

Often, if the table is located on multiple pages, select with the mouse the
desired cells is very difficult. In this case, as when working with text outside a table,
you can select the desired area by holding down the Shift key and moving the cursor
with the keys 1 and |. If you have a mouse with a scroll function, you can do the
same much faster: the Shift key will replace the left mouse button, and 1 and | -
scroll wheel.

2.4. Adding and deleting table elements

When editing the table, it is sometimes necessary to add additional elements to
it - the rows or columns. To do this, select a number of rows or columns which you
want to add. Then go to the tab Table Tools — Layout ribbon in the group of rows
and columns, click the appropriate button: Insert the top, bottom Insert, Insert Left or
Insert Right.
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Pic. Group rows and columns tab Table Tools Layout —

Another way to add items to the table - a window Adding cells. To use it, click
the button located in the lower right corner of the row and column groups. In the



window that opens, specify how to generate the insert: a shift to the right; downward
shift; insert an entire row; insert a column.
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Pic. Window Adding cells

To remove items in the table to highlight what you want to delete, and use the
Delete menu, which is in the group of rows and columns in the tab Table Tools —
Layout ribbon. You can use this same menu to delete the entire table.
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Pic. Menu button Delete

To remove a selected item, you can also perform the appropriate command
from the context menu.

2.5. Changing the size of the table of elements

Column width and row height can be changed in several ways. The easiest
ability with the mouse. To do this, move the pointer to the right border of the column
or row to the bottom border. When the pointer changes to a double line with arrows
pointing in opposite directions, move the border of a column or row to the desired
location, without releasing the mouse button. In this case the dotted line will show
where the new border will be installed.
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Pic. Setting the table border



If you want to specify the exact value of the width or height of a cell, you can
use the fields group Cell Size tab Table Tools — Layout on the tape.
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Pic. Group Cell Size

2.6. AutoFit Column Widths

When working with tables, you must pay attention to one detail: the column
width is typically too small for the text, so the program moves it to the next line,
which is often not necessary. Determine in advance exactly how much space you will
need, it is very difficult. This is what the AutoFit command. To use it, do the
following.

1. Select the table.

2. Click the Table Tools Layout — tape. Click AutoFit.
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Pic. Menu Auto Fit button

3. Select the desired option:

Autofit the contents - the column width is increased or reduced in
accordance with the contents of the cells;

Auto Fit on width of the window - this option can be used if the table has
moved beyond the page, or if you want to make the table width equal to the
width of the work area.

2.7. Table properties

In Microsoft Word 2007 provides a very convenient feature set combined in
the Properties window of the table. It can be opened by right-clicking anywhere in the
table and with the command Table Properties or by clicking the Properties button in
the Table group on the Table tab — Layout ribbon.
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Pic. Table Properties Window
In the Table Properties dialog box, you can define the following parameters:
» the location of the table in relation to the text;
* borders and shadows;
« parameters of each column and row of the table;
» the location of the text in a cell.

2.8. table Styles

If the design table for you is not easy, or you simply do not have enough time
to format the table, you will surely appreciate the presence of special stylesheets.
With their help, you can create beautifully designed table in a matter of seconds. You
will be able to quickly pick up the style of the table, create your own version of
registration or a little change is available.

Table styles are on the Table tab — constructor in the Styles group tables. By
default, the screen shows several styles (their number depends on the screen
resolution). For a full list of styles, click open the dialog box Additional parameters,
which shows an arrow pointing down. You will see a complete list of styles.
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Pic. Group Table styles

When you hover the mouse pointer over the sample style sheet in the document
immediately takes the selected design. To confirm the selection of style, click its
sample.



Word offers about a hundred automatic formatting options for different types
of tables. If you can not find a suitable option, you can create your own. To create a
style based on your table selected, use the Edit Style menu stylesheets.
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Pic. Choosing a style sheet
In the window that appears, you can select the style Change style, line color,
fill, typeface, font size of the text, and others.
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To create a new table style, use the Create style menu style sheets. A window
Creating a style similar to the style of the window Change. In this window, you can
also specify the type, line color, fill, typeface, font size of text, etc.

2.9. Sorting data in a table

Sorting data - this is one of the most important commands for the organization
of the table. The objective of sorting is often the ordering of records based on the
selected criteria. sorting is often used, if the data in the table are gradually recruited,
and each recording was made just one line below. Find information in this table is
very difficult, sorting application helps streamline data.

To sort the data in the table, do the following.

1. Select the columns to sort or place the cursor in the table, if you want to sort
the column completely.

2. Click the Table Tools — Layout, click the Details button and click Sort.
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2. In the Sort dialog box, select the column on which you want to run the
table to sort the list by first. Columns are listed by name on the left to the right.
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4. Select the sort type of data: text, number or date.

5. Set the sort order: ascending or descending order.

6. If necessary, set the parameters for a secondary sort on the second and third
columns.



7. If you want to sort in which will take into account the case of letters, press
the Options button and check the box in case-sensitive collations.
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Pic. Window Collation
8. Click OK, to confirm the selected collation.

2.10. Merge cells and setting the table.
To merge cells should:
- Select cells;
- Call the popup menu by clicking the right mouse button;
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Pic. Merge cells.
Select the Merge Cells and clicked on the left mouse button;
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Pic. The result of combining the cells.

To end the need to align the column width.

To change the framing cell caps should:
- To put the cursor inside the table;

- Tab in the Table Designer in the group — Draw border to select the required

thickness and style of the pen;
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Pic. Changing the pen style.

3. Tabulation text information in the table.



Tabulation of textual information is a way to offset the text within a paragraph

by using the TAB key.

Pressing TABprivodit to the horizontal displacement of the cursor to input a
certain distance to the right edge of the page. Default distance that moves the
insertion point is fixed. However, it is possible to arbitrarily set the point of the cursor
with the tab called tabulstopami or tab stops.

Tab stops are set for each paragraph or paragraphs of the group with the help of
a scale bar or dialog tab GlavnayallAbzats — Tab. There are several types of tab
stops defined by the alignment of the test method at the point of the paragraph.

Type of position : : o
TAB Designation Description

. . the text that is entered in this tab stops
with left-aligned 1| will be left-aligned.
on the right edge (4] the text will be aligned at the right edge

the text will be aligned at the center of

Central the tab
with a dash o when you select the icon in the tab is

inserted into a vertical bar.

Current view of the tab set click on the button "Type tab stops."
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To create a paragraph of the tab, you must:

1. to click the mouse on the scale bar;

2. sign tabulstopa move by dragging to the desired

position on the scale bar.

To use the tab means within the table structure, you must use the keyboard

shortcut Ctrl + Tab

4. Nested table: creation and use

TABLE like structure to accommodate textual information inserted into
another table called nested table.

Nested tables are a powerful tool for placing the information in a particular
form. The text of each cell of the table you can insert another table, the text in the



nested table cell can be inserted and insert a table, etc. Thus, nested tables, along with
the lists are an excellent means of embedding information reflection. Here are some
examples.

Example 1: Suppose there is a list of some of the objects - for example, the list
of enterprises. Each enterprise is characterized by certain information: name, VAT
number, address, telephone number. Each company has its own staffing and a list of
employees. Staffing and a list of employees with this model are nested data structures
in relation to the company, the data structures are completely different.

Now imagine a situation where these (or any other), heterogeneous in its
structure the data should be submitted in a single table as a single information
structure. Because data structure reflects the structure of the tables, then you must list
the staff and staffing to include in the text of the relevant cells. We get:

HanmenoBanue
Ne IITaTrHoe pacniucanue Cnmcox cOTpyAHMKOB
npeAnpUsiTHs
1 SCOI/(I)FMA» Ne | Jomkmocts K];)(J)I- Oxnan Ne D.N.0. JoxHoCTH
1 | lupexTop 1 3000 1 | UBanos HupekTop
2 | byx-p 1 | 2500 AA.
3 | Umxenep 5 | 2500 2 | Cunopos byxranrep
4 | Bogutens 2 1500 AL
5 | Cexp-pp 1 | 1500 3 | ®enopoa | Cekperaphb
N.K.
4. | Ilyraues HNnxenep
H.H.
5. | BacunseBa | Unxenep
B.A.

5. Formulas and symbols.
5.1 Inserting formulas.

On the Insert ribbon is the panel symbol containing two buttons, formulas and
symbols
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Formula button contains a drop-down menu, which contains the most commonly used
formula
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Pic. List of parts of the formula.

Button is located at the bottom of the Insert menu, the new formula, which
opens the tape menu Designer Working with Formulas.
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Pic. Menu Working with Formulas

The tape contains the Tools menu, which opens a window of fine-tuning the
parameters of formulas to insert them into the document



- -
‘J'c C}‘ MpogeccioHaneHEIW

] e e

€3 NuHeiiHbii

Popmyna .
- abe JBBIYHEIA TEKCT

wl

Cepenc

Pic. Group Service

MNapameTpbi (hopmyn

Obwme

LT no yMonuaHMio ana obnacrei dopryn:  REELIERTETGE

ABTOMATHYECKA NPECOPES0ELIBATE BEIPEHEHINA B NPODECCMOHANSHEIA hophaT
[ ¥merbwirs pasmep BnomerHsx npocTbix Apofieii B oTobpamaeMsIx dopHynax
Tpit KOMMPOBaHIK OpMYMs!

() konmposaTs MathML B Gydep ofinea kar obbiNHbIA TekoT

(%) KonMpoBaTL NuHElHLI hopMaT B fydep ofiMena Kak oBbiHHEI TekeT

Pa3pbiBaTh CTPOKM GHHAPHEIMM ONEDATOPAMA M ONEPATOPAMA OTHOLIEHMI:
[ »QBTOBaﬂEHa MaTEMaTUYECKMMK CUMBONaMA. . . ] [ EBG'IOBHEHHb\E ltly'HF-LU"IﬂI... ]

MoKaseEaTs GopMymsl
Tpi NOCTPOEHUM MHTErpancs
() pasMeCTTE NPEENs MHTErpUPOBaHMA chory
() pasMeCTHTE MPEAENS HHTEMPMPOBAHMA NO LIEHTDY CBEPXY W CHISY
Tpu NOCTPOEHUM APYrX N-aPHEIX ONEPETOPOS
) pasmectis N-apHbiz npeaent! choky
(%) pasMecTiTh N-apHbie MPEREnt! CBEPXY W CHUSY
Ecnn opHyna 3aHMMaET OTASNRHYIO CTPOKY!

Mons ofinacTi dopryn nobasnsoTos K Nonsm afisaua.

BbIpaBHWEEHME: | N0 LEHTPY KaK rpynny | %

Ecrni opMyna 3aHUMaET HECKOMBKO CTPOK:

(%) gofasnsts oTCTym:

() BLIPaBHMBETE CTPOKM Mo MPABOHY KPEHO

Pic. Options dialog box of the formulas.

Symbols menu contains mathematical signs and symbols that are used when
writing the formula
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Menu structures that displays the structure used for writing formulas
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To select the option of writing, you must call the drop-down menu of the
selected formula
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Pic. Drop-down menu formula

To select design options resulting formula can use the context menu of the
formula itself
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Pic. The context menu of the formula

Working with characters panel similar to working with formulas, if desired
character is not in the drop-down list (or necessary character setting), you can call the
Symbols menu.
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Pic. Symbol dialog box.
3. The purpose of activity of students in class:
The student should know:
1. The principles of the table structure.
. What are the possible operations on the table cells.
. How to create a table structure.
. Ways to navigate the structure of the table.

. Methods of tabulation of textual information in the table.
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. Methods for editing text in the table.
7. Principles of add / delete rows / columns in the table.

8. A method for sorting and style definition data in the table.

The student should be able to:

1. Use the opportunities Microsoft Word text processor for the submission and
processing of tabular data.

2. Create a text electronic document containing the table data, and to give them the
best for the perception of appearance.



4. Learning content:
1. Create a table structure.
2. Editing of tables.
2.1. Text editing table.
2.2. Changing the size and position of the table.
2.3. Allocation table.
2.4. Adding and deleting items in the table.
2.5. Changing the size of the table of elements.
2.6. AutoFit Column Widths.
2.7. Table Properties.
2.8. Table Styles.
2.9. Sorting data in a table.
2.10. Merge cells and setting the table.
3. Tabulation text information in the table.
4. Nested tables.
5. Formulas and symbols.
5.1. Inserting a formula.

5.2. Inserting characters.

5. The list of questions to test the level of knowledge:
1. What is the table in terms of processing technology of textual information?
2. What is the unit table structure?
3. What determines the dimensions of the table?

4. Which operations are possible with the table cells?



6. The list of questions to check the final level of knowledge:
1. List and describe ways to create a table structure.

2. Describe ways to navigate through the structure of the table.
3. List the ways to highlight rows / columns in the table.

4. How to insert and delete rows / columns in a table?

5. Describe how the editing table.

6. How is the consolidation and splitting cells?

7. How do | change the style of the table?

8. How to create a tab in a table?

9. How to insert a formula?

10. How to insert a character?

7. Establish document, collect and format the following text, in accordance with
the sample. Casting Time: 20-30 min.
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8. Independent work of students:

According to the textbook will learn the basics of creating, editing and formatting of
tables in MS Word 2007 text editor.

9. Hronokarta training session:

1. Organizing the time - 5 minutes.

2. Monitoring of knowledge - 30 min.
3. Analysis of the theme - 20 min.

4. Practical work - 30 minutes.

5. Wrap-up sessions - 10 min.

10. A list of textbooks for the class:

1. AN Stepanov Computer science. Textbook for high schools. 4th izd.g. St.
Petersburg, Peter., 2006;

2. Esaulenko IE, Semenov SN Basics of practical informatics in medicine; VVoronezh,
2005;



Theme 3: "'Standard software. Using Microsoft Excel for solving health
problems: the program interface, rows, columns, create a list of **

1. Scientific and methodological support of the theme:

Automated Information Technology (AIT), spreadsheets or tabular data
processing is the base during the spreadsheets. The user must not only be able to
enter data and to make the electronic form of any calculation, but also extensive use
of this technology to solve a large range of practical tasks.

In the healthcare professional has to face with the need to build charts, graphs,
various tables, create a simple database and work with them, to carry out the
statistical processing of data, as well as to receive and transmit information.

Spreadsheets, or, as they are called, tabular processors - is a convenient means
of calculations and analysis. They are designed to work with large tables of numbers,
in general, relatively simple to arrange a large number of calculations with identical
data, for example, accounting calculations. To develop and consolidate the skills to
create and edit charts and graphs in Excel in accordance with the requirements.

2. Brief theory:

1. Structure of the spreadsheet.
Various operations in Excel.

Spreadsheet - the Excel document - table with named columns and numbered
FOWSs.

In each cell of a spreadsheet, you can enter a numeric or textual information,
the date and time, a hyperlink, and the formula for calculating or receiving data.

Each column of the table has a name given by the letters of the Latin alphabet
(A, B, C, ..., AA, ..., AB, ..., XFD), each line - a number (1 ... 1048576). Text,
numeric information is entered into certain cells of the table. The expression "to put
into cell Al information™” means to move the cursor on cell Al (column A row 1) and
collect the necessary information from the keyboard.

Workspace Spreadsheet - Excel window area designed for data input - the
document window.



Excel 2010 file - Excel book.

Excel Worksheet - Workspace - area input and editing of information is a
table composed of 1048576 rows and 16,384 columns.

The cell of the table - the area of the electronic tadle, designed to enter
information, which has its own unique name, consisting of column name and the
serial number of the row. For example, D1.

The range of cells - an area characterized by a set of cells. Format: top left cell
in the range: the lower right cell in the range.

The formula - the contents of the cell that starts with a "=" (equal), is an
instruction to form the information in the cell.

Relative link - address of the cell that is used in the formula, which, when
moving, copying is a certain way to change depending on the insert location.

Absolute link - address of the cell that is used in the formula, which, when
moving, copying does not change. Specific reference is different from the relative
presence of a dollar sign in front of the column name and (or) the name of the line,
which means that the fixed nature of the elements of the cell address (line number,
column name).

Formatting a spreadsheet cell formatting is done through the activation buttons,
font type and size, the choice of framing or menu —Yacheyki format, where you can
fully specify the data format in the cell and its form.

Among the Excel basic technologies can be identified:

[HEN

. Data entry and editing.

N

. Enter formulas.

3. Isolation of cells.

4. Copying and moving a sheet of cells.
5. Remove the cells and data cells.

6. Filling the cells.

\‘

. Format cells.



8. Copy cell formatting.

9. Hide and show rows and columns.

10. Work with the information blocks (arrays, named ranges).

11. Data Entry Control to the wells.

12. Finding and replacing data.

13. Sort lists and tables.

14. autofilter lists and tables. Getting the results of the filtered list.
2. Window MS Excel 2010

The first time you start Excel displays a window that contains the elements of
the board corresponding to the standard setting. This window can be divided into
several areas
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Pic. Operating MS Excel 2010 window.

Areas of Microsoft Excel 2007 window when the default setting are listed
below.



1. The File tab. In version 2007 file each application there is a tab, replacing
the 2007 version of the File button command set, access to which is opened by
clicking on this button allows you to perform usual activities. In earlier versions of
Office programs, these teams were in the File menu. This, in particular, commands to
create, save, and open documents.

2. Quick Access Toolbar. When you create a document of a particular type, we
often use the same command. To each time does not "wander" in the search for the
right team around the program interface, the most "popular” team brought to the
Quick Access Toolbar in the form of small buttons with pictures. These buttons are
called tools, and a mouse click on any of them leads to the implementation of the
corresponding Excel team. Quick Access Toolbar is customizable. By default, there
are only three buttons, but by setting it is possible to print any number of Excel
commands.

3. The field specify the name of the object. It is convenient for naming various
objects table (drawings, diagrams, individual cells and groups of cells). In the future,
you can access named objects by their names.

4. Formula Bar. In this line you will enter the formula to calculate the different
values. This also allows you to edit the text string already entered formula or view it
in the case in the spreadsheet formulas are displayed instead of the calculated values.

5. Controls the main window of the program. These buttons allow you to
expand, collapse or close button in the main Excel window.

6. Control buttons child program windows. These buttons allow you to
maximize, minimize and close the Excel separate books inside the main window,
which in this case is still open.

7. The headings of the table columns. To access the individual cells within the
spreadsheet used the names of cells, which are a combination of column name and
line number, which is located at the intersection of the cell. Accordingly, the column
names are displayed in their titles. By default, Excel 2007, the standard table contains
16,384 column indicated combinations of letters of the alphabet, starting with A and
ending with the XFD.

8. Non-row table. By default, Excel standard table contains 1,048,576 lines
(more than one million!), Numbered in succession. Methods of access to cells in an
Excel spreadsheet like a game "Battleship” and should not cause you difficulty.



9. navigator page of the book. Default Excel workbook contains 3 tables, called
sheets. But in principle, the number of pages in the book is not limited except the
amount of available physical memory, the computer (as the book is loaded into
memory). Thus, the sheets in the book can be a lot more than can fit in the display
area of their tabs. In this case, the "scroll" tabs within the area set aside for them can
be carried out using the navigator.

10. Sheet tabs. By default, Excel worksheets have the book Page 1 the names
of Sheet 2 and Sheet 3. However, you can give the other adds the sheets arbitrary
names, as well as modify existing standard sheet names.

11. Status Bar. This line is identified by the state as Excel or other parameters,
as well as some of the properties of the edited document. Different areas of the status
bar are not only indicators, but also act as a tool. This means that clicking on some
icons of the status bar allows you to change the corresponding parameter.

12. Tape Tool. In Excel 2007, you will not find a menu command, which may
have become accustomed to in other Windows programs. All commands that can be
performed to Excel, are grouped by function and appear now only in the form of
beautiful icons (tools). At first glance, this beauty may seem inconvenient, because
there is no text. But do not worry: when you hover the mouse pointer over any of the
tools you will find detailed and comprehensive hint that certainly gives a lot more
information about the tool (or team) than one or two words in the name of the menu
command.

2.1. Working with the ribbon

As already mentioned, in the programs Microsoft File 2010 ribbon tools
replaced the main menu bar and toolbars are combined into a Quick Access toolbar

on the left side of the title bar.
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Pic. Quick Access Toolbar

By default, the Quick Access Toolbar handed three teams: the preservation of
the document, cancellation and refund action. You can configure this panel: add or
remove a command. To do this, click Customize Quick Access Toolbar located on
the right side panel.
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In this version of the program menu and toolbars are in the form of tape.
Commands are organized in logical groups, collected in tabs. For example, if the
formula bar is not displayed on the screen, it can be enabled by clicking on the View
tab, click Show or hide the setting and there is a corresponding flag string formulas.
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Pic. Tape.

On the ribbon displays the most frequently used commands. If this group
contains more commands and settings than shown on the tape, the down arrow button
group will open a dialog box with the rest of the teams or task pane. What is the
window you will see will help determine the tooltip.

Navigate through the tape, you can use the keyboard. Press the ALT key. All
available commands on the ribbon will prompt to go to the appropriate tab. If you
click one of the transition buttons, tooltips to all commands on this tab will be
displayed on the selected tab.

If the work area is too small, the tape can be minimized. To do this, click
Customize Quick Access Toolbar (see. The first drawing in this section) and select
Minimize the Ribbon (ribbon to display this option need to be removed). This tape
will be displayed only when you click on the header of one of the tabs and works



with its teams. To quickly show / hide the tape simply double-clicking on the header
of any tab.

Ribbon in MS Excel includes the following tabs:

» Home - basic editing operations (insert, delete, cut, copy), basic operations of
formatting tools ribbon and quick access toolbar text and specify the format of the
cells, as well as job and insert simple formulas.

* Insert - This tab is responsible for creating and inserting into the current sheet
of a variety of objects: drawings, charts, pivot tables, links to other documents.

* Page layout - everything related to the size of the sheet, the print area of the
page orientation, as well as some design parameters that affect the entire table.

« Formula - all connected with calculations in an Excel spreadsheet: insert
formulas, establishing connections between objects, naming tables and fragments of
objects, setting the parameters of the calculation.

« Data - configure connections to external data source (whether another
document or source of information on the Internet), process control data acquisition,
job placement method of the data in the table, and finally, how to display assignment
of the data.

» Review - responsible for the preparation of the table to to show it to other
people, and to work together on this table. It includes both tools to collaborate on a
document, including tools to insert notes and save the changes, and spell checking
tools.

» Type - is responsible for the way the program looks outward, visible or
hidden or that of its instruments, placing the screen at the same time open a few
windows Excel, it allows you to set the scale display for the sheet as a whole and for
its dedicated area.

2.2. Setting the status bar

By default, the status bar displays hints except brief document viewing mode
button, and select the Scale button scale. If these settings do not suit you, click on the
status bar right-click menu, you can call and set up a line as you want.
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Pic. Status bar.
2.3. Office Tab.

The File tab is on the left side of the ribbon and is responsible for the most
Important action, without which all other work just does not make sense: the creation
of the document, document discovery, document preservation, as well as printing,
publishing on the Internet and sending e-mail the file created by you. Tools File tab
becomes available when you click on this tab, the left mouse button. By default,
when you select the File tab displays a window with information about the current
document.

* Create. Create tool proposes the creation of a new empty Excel workbook or
a document based on a template. When you select it you'll see a selection window
mode of creation of the document.

* Open. Open Tool displays a standard open file dialog box.
» Save. Save Tool displays a standard File Save dialog box.

. Save as. When you select Save As tool displays the standard save file
window. This allows you to re-save an existing file in a different location under a
different name or in a different format, without making this change in the existing
saved file.

* Print. Printing Tool allows you to print the current book (sheet) in one of the
Excel offers printing devices (not always a printer).

* Information. The tool allows you to view information and change the
important properties of the document, making it available for collaborative space to
archive or send via email. The tool provides access to several commands, which will
be discussed in more detail later in the text.

* Access. Access Tool allows other users access to your document in different
ways.

* Close. Tool Close closes the current Excel workbook.



2.4. Worksheets

Each workbook is comprised of one or more worksheets, labels which can be
seen at the bottom. To go to another page, you need to click on its labels, or by right-
clicking on the button to advance tabs and select from the list the names of the
desired list. If too many sheets, the list will be the last point to All lists. By selecting
this option, you can choose any of the sheets in the dialog box.
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Pic. sheets control buttons.

Worksheets can be renamed at its own discretion. To do this, double-click on
the sheet tab and enter a new name. You can also use the ribbon tab Home — Group
— Cell Format button — Rename sheet, or right-click on the sheet tab and from the
context menu select Rename.

By default, the new book by three worksheets. To change this number in Excel
settings window in the main category, use the option Number of sheets from a group
When you create a new book. Here you can set the font and display mode, which will
be used in newly-created books default.

To rename, insert, delete, move or copy sheets, you can use the context menu
of the sheet tabs or group of commands Cells Home tab on the Ribbon.

Undelete sheet is impossible, so think carefully before deleting.



Each larch is a big table with lots of cells in which data is entered. One of the
cells in bold frame. This so-called current or active cell. The transition from one cell
to another is possible, using the arrow keys or mouse. Also suitable key TAB.
Without holding down the SHIFT key is moving to the right, with the press left

Cells adjacent to form a line, the cells are arranged one above the other to form
a column. Each cell is formed by the intersection of the row and column. To be able
to distinguish one cell from another, each cell has a so-called address, consisting of a
column number and line number at the intersection where it is located. The rows are
numbered in Arabic numerals and Latin letters columns. The address or link - is a
column name and line number, which is located at the intersection of the cell. For
example, the cell located at the intersection of column B and row 5, has an address
B5. The addresses used in the formulas as cell references. An Excel sheet resembles a
Cartesian coordinate system, only the axis arranged a little differently. current cell
address is always displayed in the name field. It is the leftmost box in the formula
bar.

Reference can specify not only one cell, but a group (range) cells. Rows on
each sheet 1,048,576, column 16, 384. (column) of the worksheet, you can press the
CTRL key and the appropriate arrow key to jump to the first or the last row.

3. Work with cells, rows and columns of the table.

In order to perform various manipulations with the contents of cells, such as
formatting, copying, or moving, they need to pre-allocate. There are many ways to
separation, are the most commonly used.

The current cell is always highlighted. To select another cell, enough to bring
to it the mouse and click the left button. To select a group of cells located near each
other, drag the mouse with the left button in the right direction at the required
distance. You can also click on the top left, and then on the bottom right of the cell
area while pressing SHIFT (this method is particularly suitable for the isolation of
large areas). Select a rectangular area of cells, called the range. Let us examine this
concept in more detail.

Range is called two or more cells of the sheet, considered as a whole. Adjacent
to the range - it is a rectangular block of cells. Represented by it by means of two
links, separated by a colon. The first of them refers to a cell in the upper left corner of



the range, and The second one is the cell in the lower right corner. For example, the
figure below highlight the range B2: C4 and E1: F2.
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Pic. The ranges of cells.

We can also consider non-contiguous ranges. They are a plurality of adjacent
Symbol is used to record non-adjacent range.
For example, the figure above shows a noncontiguous range B2: C4; E1. F2. To
select a noncontiguous range, it is necessary to consistently allocate all its member

bands are not adjacent to each other.

field, hold down the CTRL key.

If you want to allocate a very large range, which does not fit within the
screen, or range, located far from the current display area, it is convenient to
the ribbon Home tab, in the Editing group of commands to use the command

Go to the menu button and select Find.
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In the Link dialog box that appears enter a value of one or more bands (for
example, A100: A110 or C200: D205; G203: H212). After pressing the OK button,
the Excel instantly identifies the specified area.

There is a faster way to move and highlight the desired area. Enter the interval
(eg, C8: E12) directly in the name field, complete the entry by pressing the ENTER

key.

To select an entire row, click on the row header on the left side of the sheet,
where indicated by its number. The entire line is highlighted. To select multiple
contiguous rows, drag the mouse cursor across multiple title bar or click on the first
and last line of the desired range, hold down the SHIFT key. Similarly and columns
are allocated. For this purpose only headers. To select noncontiguous rows and
columns click on their headers, hold down the CTRL key. The table shows the

various methods of isolating regions.



To select:

action

single cell

you need to activate it by clicking it with the
mouse, or navigate to it using the navigation keys

a range of cells

to stretch the mouse with the left button of the
range of the first cell to the last

entire sheet

use the "Select All". It is in the upper left corner of
the sheet. Or press the key combination CTRL+A

non-contiguous or non-
contiguous cell ranges of
cells

you need to consistently isolate cells or ranges by
holding down CTRL

a large range of cells

select the first cell of the range, then press the
SHIFT key and hold it, select the last cell in the range

one line

simply click on the row header

one column

simply click on the column header

several adjacent rows or
columns

NPOTACKMBAEM MbIllb C HAXXaTOM NIEBON KHOMKOWM
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a range of cells using the
keyboard

activate the first cell, press and hold the SHIFT key
and using the arrow keys to extend the selection

greater or lesser number
of cells compared to the
current range

hold down the SHIFT key and select the last cell
you want to include in the newly allocated band

3.1. Insert rows, columns, cells, and their removal

Very often it requires either insert or delete some cells in the range of finished
table. Do not confuse the terms to remove and clean. When cleaning (using the
DELETE button, the menu button or the Delete shortcut menu command Clear
content) cells do not disappear, but only lose their contents. When deleting they really
are completely removed, and their place is filled with cells arranged side by side.

To insert columns or rows, use the Home tab. Of the group of cells, follow
commands Insert — Insert columns on a sheet or Insert — Insert Rows on the sheet.




There are other ways to insert rows and columns. Select the entire column (or
row), to the left (or top) from which you want to add columns (lines) and do one of
the following:

« tape on the Home tab, in the Cells group of commands, click Paste cell;
* Insert the command of the second group of the context menu commands.

If you select multiple columns (rows), the same number of columns (rows) and
will be added.

With the removal - even easier. To delete rows or columns, select them and
choose the Delete command on the ribbon - Delete columns (rows, cells) from a
sheet, or select the Delete command from the context menu.

If you insert rows or columns of the selected row or column (or individual cells
in them) somehow formatted, it will add an option button that reveals a dynamic
menu by adding rows or columns. Using this menu command, you can format the
rows or columns are added as one of the neighbors.

To insert a table of a certain number of cells, you must select a range in the
beginning, to the left or above which will be added to the new cell (the size of the
selected range must match the size of the pasted range), then tape the Home tab, in
the Cells group, run the command Insert — Insert the cell and choose the way add.
There may be two ways: shift down, at which the contents of the "old" cell is shifted
down and to the right shift.

Removing cells also performed with the shift. The shift may thus be either
upward or leftward. To delete a range of cells, first select it, and using the menu
command Delete — Remove the tape, select a method of removing a cell. Practice
alone, watching the program.

It should be noted that the insertion and removal of the cells should be done
with caution, t. A. In this case can easily disrupt the structure of your table, which is
undesirable.



3.2. Moving the rows, columns, cells with data

Note that when you move or copy a range of cells already filled in the range of
the old cell contents replaced. When you try such a move. Excel displays an alert. To
avoid such errors when you add data to an already full table, move the range abroad
while pressing SHIFT. At the same time the old contents of the cells shifted to make
room for the new. Simultaneously pressing the CTRL and SHIFT cell contents are
copied to a new location. If you move, you hold down the right mouse button, then
release it at the moment there is an extensive menu from which you can select the
appropriate action.
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Pic. Context menu
3.3. Changing the column width, row height

You can modify the row height and column width. For this enough to put the
cursor in the desired row or column, and on the Home tab of the ribbon in the group
commands click Format Cells. From the drop-down menu in the Cell Size group,
select the command line height or column width ... .... It should be remembered that
the height of the rows is measured in points, and the column width - in the number of
characters set the default font.

To change the width and height of rows and columns, you can simply drag and
drop the header borders. The mouse cursor then takes the form of double-headed
arrow.



If you see in the cell instead of the values of the symbols ######, then the
input data does not fit, and to see them, it is necessary to increase the width of the
column.

Double click on the border of the header row or column will automatically set
the column width or row height so as to fit all the entries. The same effect can be
achieved by using the commands AutoFit column width and row height of the Autofit
button menu Format Cells command group.

With a team of default width ... you can change the width of both the
worksheet columns.

3.4. Hide or show sheets, rows and columns

If we want to remove from the field of view (but does not delete) temporarily
unnecessary rows and columns, you can hide them. To do this, select the desired rows
or columns, and on the Home tab of the ribbon in a group of commands, click Format
Cells. From the menu that appears in the group Visibility select Hide or display, click
Hide lines (columns). You can also use the command Hide from the context menu.
Hidden rows and columns are not removed from the sheet, but simply become
invisible (leaf "composed" as an accordion). This can be quite useful if we do not
want to clutter precious screen space with unnecessary data temporarily.

To unhide rows or columns have to select adjacent to them, the top and bottom
or left and right, and execute a command line Display (columns) from the same
menu, or use the command Show shortcut menu.

Note to display the hidden columns or rows adjacent to the rows or columns of
them can not allocate separately, while pressing CTRL. It is necessary to distinguish
exactly the range to hit him and hidden rows or columns.

If the first row (column) of the sheet is hidden, you need to select the first
visible line (column) and "stretch™ the allocation to the area of the column headers
(lines), then select the display command on the ribbon or from the context menu.

Hide and display can be entire worksheets. This is done on the Home tab, in
the tape group commands cells via the menu button — Format — Hide or display the
Hide List. Before you display the hidden list, Excel asks his name.

4. Entering and editing data



To enter data in a certain cell must go to this cell by using the cursor keys ([,
[, [J, [J, Home, End) or with the mouse and enter the desired text from the keyboard
When you have entered by pressing the Enter key.

Numerical data in the cell are entered without spaces. The fractional part of the
number is always entered, separated by commas (key «.» —- point on the numeric
keypad is always perceived as the decimal part of the number). 3. If you enter the
date as a separator can be a dot slash "Slash", and the point on the numeric keypad
displayed on the screen when you type a comma.

It should be noted that if the text does not fit into one cell it is still necessary to
enter fully, press the enter, and then change the column width by pulling the right
border of the column header. The result is shown in the figure.
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Pic. Change column width

If the cell is a multi-line text input each line of text in a cell, you must complete
the key combination Alt + Enter. It is necessary to proceed from the semantic
significance of lines of text. Cell width and height, alignment data therein, the text
formatting is performed later in a separate operation.

To edit data in a cell, you must go to this cell cursor, press the F2, seine cursor
to the edit point with the arrow keys, complete the editing by pressing the Enter key.

For easier data entry and editing provides editing bar (formula bar), located at
the top of the screen when the toolbar. In the edit line reflects the content of the
current cell. If you activate this line with the mouse (to produce single-click on this
line), it will modify the insertion point line, after which it will be possible to edit the
contents of a cell.
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5. Enter formulas

The simplest way to insert in a cell Excel formula - type it in the formula bar. If
the formula is typed and interpreted correctly, its value is calculated. In the formula
bar, then displays the text of the formula and the cell - the calculated value.

When typing formulas is important to know that the formula must necessarily
begin with an equal sign (=). If you do not enter this character, the rest of the
sequence of characters to be received as text and Excel, respectively, is displayed in
the cell.

In any formula the symbols + and * are called operators (ie indicate the actions
taken), and the numbers - the operands (ie entities over which action will be
performed). In Excel formulas used limited and small set of operators that can be
grouped into four main groups:

« arithmetic operators;

* comparison operators;

* Text operator;

* operators links.

How to enter the formula in cell
1. Select the cell.

2. Enter "=" (equal);



3. Enter the cell, arithmetic or logical expression or function. To improve the
perceptibility of the formulas recommended to use spaces.

Editing formulas produced in the same manner as the editing of cells (cell
activation, pressing F2 or modify activation strings). At the same formula used in cell
stain and color names in the cell formula in the edit line matches the color of cell
borders, as shown in the figure.

f | =(12+62)* £ | (124G2)*s
C D E F G H D E F €] H
| ?D_l 2 IE12+GEi*_a. 2
Pic. The formula in cell Pic. The text in cell

5.1. Arithmetic operators

The addition operator (+) adds the operands, between which it is located.
subtraction operator (-) subtracts the second operand from the first. The
multiplication operator (*) multiplies the operands, between which there is. The
division operator (/) divides the first operand by the second. Operator percent (%)
divided by 100. The construction of the operand to the power operator (") raises the
operand to the power.

Exponentiation has its own nuances. No sign of extraction among operators of
the root, but not all users know that removing the roots of any degree can be achieved
by exponentiation. It's enough to build an operand to the power of a proper fraction,
where the numerator is one and the denominator - the degree of the root, you want to
extract. For example, to extract the square root (the root of the second degree) of 25,
25 should be raised to the power of 1/2. And in order to extract the cube root (the root
of the third power) of 27, 27 should be raised to the power of 1/3.

fe | =25%1/2) fe | =27(1/3)
D E F D E F

[ [l

Pic Rootsquaring Pic Removing the cube root



5.2. Comparison Operators

Comparison operators let you perform a comparison of the two operands that
results in a logical TRUE or FALSE.

When compared with the operator = (equal to) the compared values are equal,
the result is TRUE, otherwise - FALSE.

fe | =277(1/3)
D E F
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Pic. Compare for equality

When compared with the operator> (greater than) the left operand is greater
than the right, the result is TRUE, otherwise - FALSE.

fe | =277(1/3)>3
D E F
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Pic. Using the operator "more"

When compared with the operator <(less than) the left operand is less than the
right, the result is TRUE, otherwise - FALSE.

£ | =277(1/3)<3
D E F
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Pic. Using the operator "less"

When compared with the operator> = (greater than or equal to) the left operand
is greater than the right operand or equal to, the result is TRUE, otherwise - FALSE.
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Pic. Using the operator "greater than or equal

When compared with the operator <= (less than or equal to) the left operand is
less than or equal to the right, then the result is TRUE, otherwise - FALSE.

fe | =23<=24
D E F
| WCTVHA |
| |

Pic. Using the operator "less than or equal”

When compared with the operator <> (not equal) compared values are not
equal, the result is TRUE, otherwise - FALSE.

fe | =2323
D E F
I JIOMb _|

Pic. Using the operator "is not equal to
5.3. Text operator

Text operator in Excel only one - a & (ampersand). It serves to bring together
(concatenation), several text values into one.

S | ="ToBopuTe, Nowanyiicra, "&"tnwe!"
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Pic. String concatenation



5.4. links Operators

All of these operators allow you to insert a table of simple formulas, producing
calculations with constants or constant text values. However, at the level of
transactions with text and numeric constants Excel inferior in its ability to just school
calculator. True Excel computing power is revealed when you start to use in
reference formulas.

Operators of links in Excel two - this range operator () and the union operator
().

The range operator (:) is used to specify a range of cells. The statement
specifies the top left and bottom right \ cell allocated range.

CYMM - o f:'r| =C1:E3
A B C D E

1 [=C1:E3
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Pic. Using a range operator.

Combining operator (;) is used to combine in a single link or several ranges of
cells.

X | =C1:D%E4;FLF2]
c D E F

| -

[ 1]

Pic. Using a combination of the operator.

Links to Excel allow you to include in the formula the values contained in
other cells. The values in other cells may be the result of calculation formulas, which
in turn refer to the third cell. Thus, it becomes possible to create very sophisticated
computational structures. Thus references to other cells in the formula are equivalent
insert is not constant, but variable. Changing the manually or automatically values in
those cells that are linked to, and you change the final result of the calculation
formula.



5.5. Relative and absolute references

Those references that were used in this example are called relative, they point
directly to a specific cell by its address (C6, D9), but if you copy a link to another
cell, the address change. It is fixed with respect to the cell in which the formula is and
will always point either above or below, right or left on the same number of columns
and rows.

Relative references are saved, if you copy the contents of a cell, but if you
move the cell containing the link (by dragging and dropping or cutting and pasting a
combination of operations), the link becomes absolute.

Absolute link- is a link that always points to the same fixed cell no matter
where and how you copy or move it. If you want to link to was absolute, you will
need when entering the reference in the formula bar to indicate this by using the
dollar sign ($) before each of the coordinates of the reference, for example, $ A $ 1.
In addition, you can use this label only one of the coordinate reference. Then the part
of the reference will be relative and will remain part of the absolute, for example, or
the A1 $ A $ 1. In the case, when you do one of the absolute coordinate reference, the
reference will always point to the same fixed column or on the same fixed line.
Quickly switch with relative references to absolute or partially absolute can be made
while in the formula bar by pressing the F4 key. This results in the following cycle
through:

Al - $AS1—->5A1—>AS$1— AL

5.6. References to cells in other worksheets and in other books

In order to insert a reference to a cell that is in the current book, but on
another sheet, you need to enter in the formula bar as a link

Pagename! Cell_reference

In order to insert a reference to a cell that is in another workbook, you
need to enter in the formula bar as a link

[Imya_knigi] pagename! Cell_reference

For example, the link located in the cell on Sheetl in Bookl book and
pointing to a range of cells, located in the Contacts list in the test book, looks
as shown in Fig.

This entry means that the test book is located in the same directory as the
book Bookl. However, if the book to which you refer, is located in a different
directory, you should specify the full path to access it directly in the formula.
That will look like previous reference to a cell in a book that is in the directory



C:\ My \ Docum:
= C:1'\ My \ Docum \ [test] Contacts C1: C3

3. The purpose of activity of students in class:
The student should know:
1. The main structural elements of the spreadsheet interface.
2. Basic terms of an Excel spreadsheet.
3. The principle of a spreadsheet.
4. How to enter data, format the data in the cells.
5. How to select, copy, and delete data in the cells.

The student should be able to:

1. To have the basic tools to process text and numerical information.

2. To enter and edit data using the editing line and directly into the cells.
3. Perform calculations by entering formulas, copy, delete information.
4. Asking the desired format in spreadsheet cells.

5. Hiding rows and columns

4. Learning content:
1. Structure of the spreadsheet. Various operations in Excel.
2. Window MS Excel 2010.
2.1. Working with the ribbon.
2.2. Setting the status bar.
2.3. Office Tab.
2.4. Worksheets.
3. Work with cells, rows and columns of the table.
3.1. Insert rows, columns, cells, and their removal.
3.2. Moving the rows, columns, cells of data.
3.3. Changing the column width, row height.
3.4. Hide or show sheets, rows and columns.
4. Data entry and editing.
5. Enter formulas.
5.1. Arithmetic operators.
5.2. Comparison Operators.
5.3. Text operator.
5.4. Operators references.
5.5. References and names.
5.6. Relative and absolute links.
5.7. References to cells in other lists, and in other books.
5. The list of questions to test the level of knowledge:
1. What you can list basic Excel-2007 Technology?



2. How is the input and editing of data in Excel-2007? The process differs from the
similar process in Word?

6. The list of questions to check the final level of knowledge:
. Define the spreadsheet.
. What is the sequence of operations to be performed by the user to enter formulas?
. How to place the text in two lines in a single cell?
. List the main methods for isolating cells.
. List the main ways of copying the cells.
. How is the cell formatting?
. Which group of formulas exist. Briefly characterize.
. What is the absolute reference?
. What is the relative reference?
0. What is the use autofill and how it is carried out?

P OO ~NO O WNE

7. Create a document type and format in accordance with the model:
Create and format the table below "Calculation
monthly hospital board. " Perform necessary calculations values of table cells marked
with the "?" On the following formulas. Created table should be placed on a single
typewritten sheet book formata.Posle this sort the data in alphabetical order by

"Name" column and filter the table in the column "Position".
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DopMyJIbI:
I'pagpalO = I'pagpab * I'paghad | I'pagha 8
I'pagpall = I'pagpalO * 0,13
I'pagpal2 = I'pagpalQ — I'paghall
Requires:
1. Calculate the "Total" row.
2. Perform a payroll for the company for June 2000

8. Independent work of students:

Learn the basic principles of creation, spreadsheet, enter a formula in MS Excel 2007.
9. Hronokarta training session:

1. Organizing the time - 5 minutes.

2. Monitoring of knowledge - 30 min.

3. Analysis of the theme - 20 min.

4. Practical work - 30 minutes.

5. Wrap-up sessions - 10 min.

10. A list of textbooks for the class:

1. AN Stepanov Computer science. Textbook for high schools. 4th izd.g. St.
Petersburg, Peter., 2006;

2. Esaulenko IE, Semenov SN Basics of practical informatics in medicine; VVoronezh,
2005;



Theme 4: "'Standard software. Microsoft Excel. Using the built-in statistical

functions to solve medical problems

1. Scientific and methodological support of the theme:

To study the basic Excel functions and how to use them

in tabular calculations.

To perform calculations in Excel formulas, you can also use the built-in
Excel functions. Excel functions used to calculate the arithmetic and logical
expressions, operations on the data. There are also functions to work with dates
and times.

To develop and consolidate the skills to create and edit charts and graphs
in Excel in accordance with the requirements.

To solve the communication problems it is necessary to provide tabular
information in graphical form, facilitates the perception of information,
simplifying the process of comparing dissimilar data. For this purpose, various
means, the main of which graphs and charts. Although graphs and charts can
be quite effective means of communication (to promote understanding of the
material), but they are also able to easily enter the recipient information
misleading if the wrong type is selected graphical tool or graphic design is
incorrect.

Given the opportunities Microsoft Excel program in the field of
mathematical and statistical calculations, it is often necessary to display the
results graphically. This allows you to solve a variety of problems. Microsoft
Excel has extensive capabilities for graphical representation of information,
ease of creation and modification. Diagrams are a means of visual data and
make it easier to perform comparisons, identify patterns and trends in data.

2. Brief theory:

1. The concept of function.

Expressions that are used in the calculation of functions, called function
arguments. The arguments of the function may be different expressions,
reference data ranges, as well as other functions. Excel Function arguments are
enclosed in parentheses, and are indicated by a semicolon ";".

The order in which the arguments must follow function, called the
function syntax.

Name of the function and its syntax format up function.

The most common functions to Excel format

= <Function name> (<argument list>)

function name should not contain spaces and must begin with a letter.
Gaps between the function name and the parenthesis are not allowed.
Parentheses are used to determine the beginning and end of the argument list,



and should be paired. Gaps in front brackets and after the brackets are not allowed.

The argument list can consist of different types of expressions. The type of
each expression in the argument list must be a valid argument for this in accordance
with the syntax.

As is known, any Excel formula begins with an equal sign followed by the
arithmetic, logical, or any other expression in the composition of which may include
Excel functions. If the function is at the beginning of the formula, then it must be
preceded by an equal sign.

The functions is an argument to another function or a part of its expressions, is
called nested. In Excel, you can use up to seven levels of nested functions.

Each built-in function belongs to any category.

1.1. Basic Excel functions.

According to the type of data being processed can cause the following
classification embedded Excel functions.

1. Mathematical functions - the most frequently used functions for the
processing of numerical values.

2. Logic functions are designed to provide conditional calculations in
mathematical expressions and processing of logical expressions.

3. Text functions used for text information

4. Functions for date and time.

Completely lead syntax and description of built seems redundant, as meaning
most of the features evident from their names. Full description of the syntax and a
built-in function is recognized when it is selected wizard dialog functions (as shown
in Fig. Above).

The following groups can be distinguished among the basic mathematical
functions:
- Function type conversion and bring them (CEILING,

FLOOR, ROUND, ROUNDUP, ROUNDDOWN - rounding operations
TRUNC - discarding the fractional part, the whole - the transformation to an integer).
- Trigonometric functions (SIN, COS, TAN, ASIN, ACOS, and others.);

- Logarithmic (EXP, LOG, LN, LOG10);

- Arithmetic (sum, make, sign, ROOT, LEVEL, THE FACT MOD);

- Array processing functions (SUM, PRODUCTIVITY, SUMSQ,

SUMPRODUCT, SUMIF - different kind of sum; MDETERM, MMULT -
matrix operations).

Logic functions (AND, OR, IF NOT, TRUE, FALSE).

Basic text functions:
LEFT, RIGHT, MID - allocation of a certain number of characters per line.



LEN - length of the string.

VALUE - convert text to a number.

T - converts a number to text.

TEXT - converts a number to text and format it.

REPEAT - repeats a given text a specific number of times.

Recipe - converts all uppercase letters in line.

LOWER - Converts all lowercase letters in a row.

TRIM - deletes from the text extra spaces, except spaces between words.

Functions of "Date and Time"

In Excel, the date and time have an idea in a single data type (type "Date
and Time"), representing a certain number. date and time as the representation
of a whole number is necessary to simplify the operations with date and time.
For the user, the numeric representation of date and time is transparent, i.e. The
date and time are recorded in Excel cells in the usual human form. If you select
a group of cells that contain the date and time, and set the cell format as "Total"
(Format [] cells... ® View ® General), it will be reflected numeric
representation of the date and time instead of the traditional. To go back to the
traditional representation of the date and time, you must also select a group of
cells and assign them the type of "Date and Time" (Format [ cells [1 View [
date and time).

TODAY - returns the current date.

YEAR DAY, MONTH - return respectively the year, day, month as a
single number.

DATEVALUE - Converts a date in the text representation of a numeric
type "Date and time".

Date - returns the date in the numeric format on the basis of parameters
year, month, day.

Time - returns the time in the format of the date as a number of
parameters on the basis of the hour and minute.

Second, minute, hour - returns from the format "Date and Time"
seconds, minutes and hours respectively.

Special Categories embedded Excel functions.

1. Financial functions (see. Section 3 of this book).

2. Statistical functions (MIN, MAX, AVERAGE, COUNTIF).

3. Functions for working with databases.

4. Functions to work with references and arrays.

1.2. The most commonly used built-in functions.

Here is the syntax and meaning of some commonly used built-in
functions.

SUM - summation of cell values

Syntax:

SUM (numberl; number2; ...)



where numberl, number2 ... - a specific number, the cell range or the name of
the range.

Since the addition of cell values using the SUM function is one of the most
common tasks in Excel to perform this task, there AutoSum tool.

To use the AutoSum tool, you must move the cursor to the cell that contains
the sum. Next, activate the tool and click the mouse a certain range, and then press
Enter.

You can carry out a similar operation in another way: select a range of cells are
integrable with the final row / column and press Alt + =.

IF - performing operations in accordance with condition

Syntax:

IF (boolean; znachenie_istina; znachenie_lozh)

IF function returns znachenie_istina if the condition is true and znachenie_lozh
if the condition is false.

COUNTIF - the number of non-empty cells in the specified range that meet
specified criteria.

Syntax:

COUNTIF (range, criteria)

where the interval - cell area, which counts the number of cells; criterion - the
criterion in the form of a number, expression, or text that defines which cells need to
count. For instance, "> 2500".

SUMIF - the amount of cell values that meet certain criteria.

Syntax:

SUMIF (range, criteria, summ_interval)

where the interval - cell area, for which the criterion is calculated; criterion -
the criterion in the form of expression, or text; summ_interval - cells for summation.

MAX - the maximum value from a list of numbers.

Syntax:

MAX (numberl, number2, ...)

where numberl, number2 ... - a specific number, cell area or range names.

MAX - minimum value in a list of numbers.

Syntax:

MIN (numberl, number2, ...)

where numberl, number?2 ... - a specific number, cell area or range names.

FASHION - the most common number

Syntax:

FASHION (numberl; number2; ...)

AVERAGE - arithmetic mean

Syntax:

AVERAGE (numberl, number2, ...)



1.3. Writing and editing functions.

You can enter functions in a worksheet directly from the keyboard or by
using the menu command Insert function. When you enter the function from
the keyboard is better to use lowercase letters. When the function input is
completed, Excel will change the letters in the function name to uppercase, if it
was entered correctly. If the letters are not changed, then the function name is
entered incorrectly.

If you select a cell and select Insert Function command, Excel displays
the dialog box Function Wizard. A little faster, you can achieve this by
pressing the icon functions in the formula bar.
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Pic. Insert function.
To open this window, you can also use the Insert Function button on the
Standard toolbar.
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Pic Dialog Box Function Wizard

In this window, first select a category in the Category list, and then in
alphabetical list function, specify the desired function.

Excel enters the equal sign, function name, and a pair of parentheses.
Then Excel opens a second dialog box Function Wizard.
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Pic. Select function arguments

The second window of dialogue Function Wizard contains one field for each
argument of the function selected. If the function has a variable number of arguments,
this dialog box when the water expands additional arguments. Description of the
argument, that the field contains an insertion point, is displayed at the bottom of the

dialog box.

To the right of each field argument displays its current value. This is very
handy when you're using references or names. The current value of the function is

displayed at the bottom of the dialog box.

Click OK, and create a function appears in the formula bar.

A v fe | =cymMm(AL:AZ)
A B c D
1 10
2 23
3 56
4 ss_l
Pic. SUM function.

2. Use of the analysis packet

Analysis package is an add-Excel- set of tools and instruments that extend the

standard capabilities of Excel related data analysis.
Possibilities of data analysis add-in package:
1. Univariate analysis of variance.

2. Two-factor analysis of variance with repetitions.
3. Two-factor analysis of variance without repetition.

4. Correlation.

5. Covariance.

6. Descriptive statistics.

7. Exponential Smoothing.
8.Dvuhvyborochny F-test for variances.



9. Fourier analysis.

10. Histogram.

11. The moving average.

12. Generating random numbers.

13. Rank and percentile.

14. Regression.

15. Selection.

16. Paired Two Sample t-test for average.

17.Dvuhvyborochny t-test with equal variances.

18.Dvuhvyborochny t-test with different dispersions.

19.Dvuhvyborochny z-test for means.

To use one of the tools for packet analysis studied data should be presented in a table,
where the columns are the corresponding figures. When you create an Excel
spreadsheet information is entered in the individual cells. The set of cells containing
the analyzed data is called input interval.

To use a set of tools and analysis tools package is necessary to make its installation.
Complete these steps:

Open the Quick Access Toolbar. And the menu, select More Commands.
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Pic. Opens the Excel Options

You will see the Excel Options dialog box, in the right window, select
the VBA function analysis package.
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Pic Configuring Packet Analysis.

Click the button Go and click on OK. Add-ons dialog box will appear.
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Pic. Settings dialog box.




Put a check box package analysis and confirm your selection by pressing

the OK button. Thus established analysis package.

For further work on the ribbon, select the Data tab.

analysis function.
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Pic. Call functions data analysis

Next, choose the command data analysis — — analysis of the data. In
the Analysis Tools window that opens, select Descriptive statistics
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Pic. Working with the function of Data Analysis

Appears Descriptive Statistics dialog box.
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Pic. Descriptive statistics dialog

Fill in the statistical parameters as follows:

In the Input range - a range of cells with data for statanaliza, in the output
range - the address of the cell, which can be written analiza.VV parameters output
result set check box in the Summary Statistics and click on OK
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Pic. Entering data Descriptive statistics dialog

As a result of underlying transactions get calculated indicators of descriptive
statistics.
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Pic. Results Descriptive statistics.

3. Diagrams.

Diagram - is a way of visualizing the information given in the form of a
table of numbers. Demonstration of data using charts is more intuitive and
effective for sensing.

Create a chart

Charts are based on data contained in the worksheet, so they must be
entered before creating the chart. Dynamic Charts in Excel, t. E. Are
automatically updated when the data changes on the basis of which are built.
The diagram can be placed both on the data sheet, or on a separate sheet
(taking the entire sheet).

Default chart consists of the following elements:

» Rows of data - is the most valuable, because visualize data;

* Legend - contains the name of the series and an example of their
registration;

* Axis - specific price range with intermediate divisions;

* The area of construction - is the backdrop for a series of data;

* The grid lines.

Besides the above-mentioned objects, such as can be added:

* The names of the chart;

» The lines of the projection - descending from the data series on the
horizontal axis line;

* The trend line;

» Signatures of data - numeric value for the number of data points;

* And other infrequently used items.



3.1. Adding charts.
To create the chart is necessary to pre-select the data range, click the desired
chart type button on the Insert tab, Charts panel.
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Pic. Box charts.
The selected graph will be built immediately on the sheet.
Also, a chart can be added by calling the dialog box, insert the chart.
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Pic. Dialog Box chart.

In this window, choose the desired chart type and its species.

At the same time on the tape main menu contextual tool Working with
diagrams containing tabs: Design, Layout, and Format. These tabs are located basic
tools to edit and format the chart.

3.2. Changing the chart
The graph can be changed using the buttons like the corresponding panels and
context menu items by pressing the right button on the selected chart element.
Design tab consists of panels: The type of data, the layout diagram, chart style,
location. Basic operations performed by these tools: Changing the chart type and
location of its data and style.
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Pic. tab Designer

Panel type is designed to change the type of the diagram. Save as
template allows you to save for later use by the user change the chart.

On the panel, you can select new data or correct the selected data range
(add / delete rows of data), data interchange in a row on the data in the column.

The panel layouts diagrams can apply one of the available layouts design
diagrams of this type.

Styles panel diagrams allow us to apply the styling of the whole diagram.

Location panel is designed to change the location of the chart: move to
another worksheet or placed on a separate.

Layout tab contains a panel: current track, Insert, Signature, AXis,
Background, Analysis, Properties. These tools are designed to add and
customize individual chart elements.
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Pic. Layout tab

Current track panel lets you select a diagram element (diagram elements
in the list) and format (format of the selection button) or return to the original
formatting of the form (the Restore button style formatting).

Insert Panel need to insert graphics, figures and inscriptions in the chart.

Signatures panel allows you to add and place in the chart corresponding
to the signature elements: chart title, axis titles, legends, data table.

With the axis of the panel in the chart shows the main axis and grid lines.

Background panel is designed for adjusting the parameters of the field of
construction, as well as three-dimensional charts elements (Chart Wall, Chart
Floor, D Rotation).

Format tab panel includes: current track, Shape Styles, Styles of the
WordArt, Sort size tools to format individual chart elements.
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Pic. Format tab

Panel Current track works similar to the same panel in the Layout tab, and
formats the selected item.

On the Shape Styles panel, you can configure the desired design style, set the
fill color fringing (circuit), the effects of the selected diagram element.

WordArt Styles panel lets you specify the layout of text elements present in the
chart (the signature of the axes, titles, legends, etc.).

Arrange panel allows you to control the placement of objects (charts) on the
sheet relative to each other.

Panel size is accurate to define the size and scale of the chart.

3.3. Move, copy, delete charts

To move the chart sheet to another location, you need to select it and drag the
left mouse button. To move a chart to another sheet, you must use standard
commands for cutting out (Home — Clipboard — Cut or the keyboard shortcut Ctrl +
X) and paste (Home — Clipboard — Paste or key combination Ctrl + V). To move
the chart and placed on a separate sheet you need to use the command

Working with Charts Designer — — — Location Move the chart.

To copy a chart sheet to another location, you must move the chart by holding
down the Ctrl key, a new place to get her copy. To copy the chart, located on a
separate page, you need to move Ctrl-tab of the sheet, resulting in the book will be
added to the sheet with a copy of the chart. Also can be used to copy the standard
Copy command (Home — Clipboard — Copy or the keyboard shortcut Ctrl + C) and
paste (Home — Clipboard — Paste or key combination Ctrl + V).

To delete a chart select it enough and press the Delete key. To delete a chart on
a separate sheet to click on the sheet tab and right click on the shortcut menu, choose
Delete.

4. The most commonly used types of charts.

In Excel, use the following chart types:

* histogram;

* Schedule;

* The pie chart;

* Line Chart;

 Area Chart;

* Scatter

» Stock market chart;



* Surface chart;
* Doughnut;

* Bubble chart;
 Radar.

4.1. Histograms

In the diagrams of this type of axis OX of, or categories axis is
horizontal, axis OY - value axis - vertically. The histogram has seven subtypes,
of which it is always possible to choose the most suitable type for the graphic
display of the available data:

» a group - displays the values of different categories;

* the accumulation of - displays the contribution of each category of data
in the total;

» normalized with accumulation - indicates the proportion (%) of each
category of data in total;

* the volume with the group;

e the accumulation of volume;

* volume normalized to the accumulation;

* volume histogram.
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Pic. Types of histograms.

With the pie chart can be displayed only one data series, each element of
which corresponds to a certain sector of the circle. The area of the sector as a
percentage of the area of a circle is equal to the share of total cell number in the
sum of all the elements.

4.2. graphics

Graphs are commonly used when you want to define the behavior of a
function or process. Excel allows you to build a 7 chart types, divided into 3
categories: graph chart with markers and a volume graph
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Pic. Types of charts



For example, consider plotting funktsiiy = sin (x) in the interval of one
complete period. To do this, you need to build a table containing a column of
arguments and column values of the function. When plotting points on the set without
the use of anti-aliasing some broken line is obtained.

In order for Microsoft Excel 2007 to display on the screen, smooth line, you
should enable anti-aliasing mode. To do this, select the charting and cause a number
of command Format pop-up menu data. In the window that appears on the tab Line
Type, select the option Smooth line and press Close. As a result, the graph of the sine
function takes the form shown in Pic
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Pic. The graph of the function y = sin (x) without gmbothing
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Pic. The graph of y = sin (x) with anti-aliasing |

4.3. Pie charts

Circular diagrammy- is a circle divided into sectors (cake), and are used to
show the relative values are integrated. The largest sector of the circle should be the
first in a clockwise direction from the top. Each circle sector must be marked
(required name, value and percentage). If you want to focus on a particular sector, it
is separated from the rest.

Circular chart type is useful when you want to display the values of each share
in the total amount.



We construct a three-dimensional pie chart that displays the loading of
production during the year.
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Pic. The data for charting.

With the pie chart can be displayed only one data series, each element of
which corresponds to a certain sector of the circle. The area of the sector as a
percentage of the area of a circle is equal to the share of total cell number in the
sum of all the elements. Thus, the sum of all shares of seasonal is 100%. Pie
chart created on the basis of these data is shown below:
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Pic. Pie chart.

6 types of pie charts are presented in Excel:
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Pic. Forms of the pie chart.

» Circular - shows the contribution of each value to the total amount;

* volumetric circular;

» Pie - part of the core values of the charts presented for the second chart;

« circular cut - value sectors separated from each other;

* volumetric cut circular;

» secondary histogram - a part of the basic values of the chart is moved
to a histogram.

If a pie chart is required to separate sectors, does not necessarily change
the chart type. Just select the circle and drag any sector from the center. To



restore the original appearance of the chart, drag the sector in the opposite direction.

3arpyska Nnpou3BOACTBa B TeYeHue roga
(no cesoHam)

3uma BecHa
16% 22%

OceHb
28%

Jleto
34%

Pic. Changing the appearance of the pie chart.

It should be remembered that if you want to separate just one sector, it should
be made on the two single clicks. The first will provide a series of data, the second -
specified sector.
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Pic. Changing the appearance of the pie chart.

The pie chart sectors 360L] can rotate in a circle. To do this, select the Layout tab
on the Ribbon and click the selected format.

The secondary pie chart as a bar graph and secondary, allowing some of the data
displayed separately in more detail in the minor chart or histogram. Moreover
secondary chart diagram is recorded on the primary as a separate fraction. For
example, consider a graph that displays sales for the week with the portion
attributable to the weekend, taken out in the form of a secondary pie chart. When you
select the chart type indicates Pie.



greepr; 1 .
D ockpeceHbe; 8%

.“""\ | B | ’cpeua; 17% ‘
1 |noHegenEHHE 299% _ y
2 |BTORHME 16% 8
3 CF:IE,D,E 1?% noHeaenbHUK29%
4 |uyeTeEpr 12%
5 |nATHWUA 15%
G .ﬂp}"rﬂﬁ 139, O noHeaenbHWK B BTOPHUK Ocpena O veTBepr
7 C},I'EEEITS gy, B nNaTHULA O apyroit B cy660Ta O BoCKpeceHbe
§ |eockpeceHee 5%

Pic. Secondary chart.

The data are arranged in columns and rows, it can be represented as a
scatter plot. Scatter plot showing the relationship between the numerical values
in rows or multiple data displays two group numbers as a series of x and y
coordinates.

Scatter has two axis values, with some numerical values are displayed
along the horizontal axis (X axis), and the other - the vertical axis (Y axis). In a
scatter chart, these values are combined into a single point and are displayed at
irregular intervals, or clusters. Scatter charts are typically used for illustration
and comparison of numerical values, for example, scientific, technical or
statistical data.

4.4. Scatter charts

Scatter charts are recommended if:

* You want to change the scale of the horizontal axis.

* You want to use for the horizontal axis logarithmic scale.

* The values on the horizontal axis are arranged irregularly.

* The horizontal axis has lots of data points.

* You want to effectively display data spreadsheet that contains a pair of
grouped fields with values, and introduce independent scale scatter plot to
display more information about the grouped values.

* You need to show no difference between the data points, and similar in
large data sets.

* You need to compare multiple data points without regard to time. The
more data that will be used to construct the scatter plot, the more accurate
comparison.

To output the data as a table to place the scatter plot data on the X axis in
one row or column and the corresponding data on the Y axis - in adjacent rows
or columns.
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Pic. Scatter chart with markers.

Scatter charts have the following chart subtypes:

* Scatter chart with markers. Diagram of this type allows you to compare a pair
of values. Scatter with data markers but without lines should be used when many data
points and connecting lines may impede their perception. This type of chart can also
be used if there is no need to show a link between data points.

» Scatter chart with smooth lines and scatter chart with smooth lines and
markers. The diagram of this type of points are connected by smoothed lines. Such
lines may be displayed with or without markers. Smoothes the curve without markers
should be used, if the data points are many.

 Scatter charts with straight lines and scatter chart with straight lines and
markers. The diagram of this type of data points are connected by straight lines.
Direct can be displayed with or without markers.
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Pic. Types of scatter charts.

3. The purpose of activity of students in class:
The student should know:
1. How to call the master functions.
2. The intended use is "Built-in functions".
3. Categories of built-in functions.
4. What is the range finder.
5. What is the range of data.
6. How to call "Charting Wizard."
7. Appointment of the tool "Chart Wizard."



8. Types of graphs and functions.
9. What is a "number”.

10. What is the range of data

11. What is the "Legend"

The student should be able to:

1.Imet skills in MSEXCEL program.

2.Umet use the tool "Built-in" for the calculation of various kinds of indicators.

3. Use "Chart Wizard" tool for the construction of various types of graphs.
4. Learning content:

1. The concept of function.

1.1. Basic Excel functions.

1.2. The most commonly used built-in functions.

1.3. Writing and editing functions.

2. Use of the analysis packet

3. Diagrams.

3.1. Adding charts.

3.2. Changing the chart

3.3. Move, copy, delete charts

4. The most commonly used types of charts.

4.1. Histograms

4.2. graphics

4.3. Pie charts

4.4. Scatter charts

5. The list of questions to check the initial level of knowledge:
. What is the use autofill and how it is carried out?
. How is the input of formulas in a table cell?
. What are the ways to place text in the table cells?
. List the main ways of copying and isolation cells.
. Remove the cells and data cells.
. Adding cells
. Filling cells
. What is the hidden rows or hidden columns?
. Identify and describe two basic ways how to temporarily remove the information
contained in the specific rows (columns) of the table?

OCOoOoONO OIS, WN B

6. The list of questions to check the final level of knowledge:
1. What is the built-in Excel function?
2. Describe the classification of built-in features on the types of data being processed.
3. What can be used as arguments to the built-in function?
4. What types of built-in functions related to specific areas.



5. What is the range finder? Describe the work with him.
6. Using the AutoSum tool.
7. Describe the form you built in Excel functions.
8. Describe how to perform the work. How should the work be framed? How should |
present the results of the work done.
9. Why do we need to build charts and graphs?
10. What is the number of data?
11. Describe the process of creating a chart or graph?
12. List the required elements of any design graphics and diagrams?
13. How is the change in the parameters to create a chart?
14. How do | change the font of the text information in the chart?
15. What is the area of the chart? How to resize it?
16. How do | change the type and color of the line on the graph of the chart?
17. Why is the standard way to create a chart or graph is almost always needs work?
18. Describe how to perform the work. How should the work be framed? How should
| present the results of the work done?
7. The practical part:
1. Create a document type and format in accordance with the model using the
formatting tools.
2.Rasschitat given to the practical task performance with the use of built-in features,
and plot the function:

Option 1.Neobhodimoe time to perform 20-30 minutes
Baseline data are presented in the following table:

Ne | ®.1.0. CoTpyaHUKa AonKHOCTb Oknap,
1 MBaHoB MBaH NBaHOBWY Aunpektop 5 000
2 Cunpopos Metp Nnbuny FnaBHbIM byxrantep |4 000
3 dPepoceeBa KatepnHa MBaHOBHA byxrantep 2 500
4 NetpoBa NpnHa HMKONaeBHa byxrantep 2 000
5 Makapos KoHcTaHTUH CTenaHoBMY Knagoswuk 2 000
6 ActaneHko Cepren Cepreesuny DNEeKTPUK 1500
7 baknaHoB Anekcen Bnagmmuposuy MNpopasey, 1500
8 NlomakuH NeHHagm Buktoposuy Npoaasel, 1500
9 BanepbaHoB Hukona Uropesuny [py3umnK 1 000
10 Pomawosa TaTtbAHa BnagummposHa MNpopasey, 1200

It is required to determine the following parameters:
Payroll for the enterprise; the maximum and minimum salary; average salary; the
number of employees with a salary of less than a certain amount; Payroll staff with a



salary of less than a certain amount; the proportion of employees with a salary of less
than a certain amount, in the total payroll.
8. Hronokarta training session:
1. Organizing the time - 5 minutes.
2. Monitoring of knowledge - 30 min.
3. Analysis of the theme - 20 min.
4. Practical work - 30 minutes.
5. Wrap-up sessions - 10 min.

9. Independent work of the student.
Learn the basic principles of the functions of the Master (text and logical) principles
charting in MC Excel 2007.

10. A list of textbooks for the class:
1. AN Stepanov Computer science. Textbook for high schools. 4th izd.g. St.
Petersburg, Peter., 2006;
2. Esaulenko IE, Semenov SN Basics of practical informatics in medicine; VVoronezh,
2005;



Topic 5: "SUBD MS Access. Organization of databases: by entering data; using
a wizard; using the constructor, by importing the spreadsheet data; the creation
of multi-table database to solve medical problems **

1. Scientific and methodological support of the theme:

This policy tool as a working environment database development and
programming for their Microsoft Access package has been selected, which is part of
the Microsoft Office suite. The main reason for such a choice - the prevalence of this
environment and the availability of its development for the non-programmer-users.
Microsoft Access is currently the most popular desktop database management system
(DBMS table). The term "board" here means the ability to create and use databases
on a personal computer. If you have the necessary skills and background knowledge,
anyone can create on your PC database and successfully use it in your everyday tasks.
Currently, a large number of databases, accounting systems and analysis of the
economy performed using Access. Database Applications built using this
environment, now used in medicine. Of particular value is the knowledge of this
environment for medical practice: there are a lot of data processing tasks that such a
popular tool as Microsoft Excel can not cope or its use will not be effective for these
tasks. Such tools as Access will allow in this case, clearly structured and well-
organized work with a lot of medical information tables.

2. Brief theory:
1. Concepts Databases

Development of computer technology was carried out in two main directions:

* the use of computer technology to perform numerical calculations;

* The use of computer technology in information systems.

Information system - a combination of software and hardware, methods and
people who provide collection, storage, processing and delivery of information for
the task. In the early stages of information systems used file processing model. In the
future, the database began to be applied in information systems. Databases are a
modern form of organization, storage and access to information. Examples of large-
scale information systems are the banking systems, train tickets and ordering systems,
etc.

Database - an integrated set of structured and interrelated data organized
according to certain rules, which include the general principles of description, data
storage and processing. Typically, the database is created for the domain.

Specialization - this is part of the real world, to be studied in order to create a
database to automate the management process.

A set of principles that define the organization of logical data storage structures
in the database are called data models.

There are 4 main data model - lists (flat table), relational databases,
hierarchical and network structures.



For many years, mainly used in flat table (flat DB) type in Excel lists.
Currently, the most widely used in the development of database received a
data model. The relational data model is a collection of simple two-
dimensional tables - relationships (English relation.), le. The simplest two-
dimensional table is defined as the ratio (lots of similar accounts united by one
theme).

From term relation (ratio) comes the name relational data model. In the
relational database using multiple two-dimensional tables in which rows are
called records and columns are fields between records which connections are
established. This organization of data allows data (records) in a table associated
with the data (records) in the other tables through a unique identifier (key) or
key fields.

2. Basic concepts of relational databases: normalization, communication and keys
2.1. The principles of normalization:

1. In each table, the database should not be repeating fields;

2. In each table must have a unique identifier (the primary key);

3. Each primary key value must comply with sufficient information on
the type or nature of the object table (for example, information about the
progress of the group or student);

4. Change the values in the table fields should not affect the information
in other fields (except for changes in the key fields).

2.2. Types of logical connection.

Communication is established between the two general fields (columns)
of the two tables. There is an attitude of "one-to-one", “one-to-many" and
"many-to-many".

The relationships that can exist between the records of two tables:

 One-to-one relationship, each record in one table corresponds to one
record in another table;

» one-to-many relationship, each record in one table corresponds to the
number of records to another table;

« Many-to-one basis, a plurality of records from one table corresponds to
one record in another table;

» Many-to-many, many records from one table corresponds to multiple
records in the other table.

Type of relationship created in connection depends on how you define
linked fields:

 The ratio of "one-to-many" created in the case where only one of the
fields is a field or a unique primary key index.

» The ratio of "one-to-one™ is created in the case when both fields are
linkable key or have a unique index.



* The ratio of "many-to-many" relationship is actually two "one-to-many" third
table where the primary key consists of the foreign key fields of the other two tables
2.3. Keys.

The key - a column (may be multiple columns) to be added to the table and
can be linked to records in another table. There are two types of keys: primary and
secondary or external.

Primary key - it is one or more fields (columns), the combination of values that
uniquely identify each record in the table. The primary key does not allow Null
values and must always have a unique index. A primary key is used to link tables
with foreign keys in other tables.

External (secondary) is a key-one or more fields (columns) in the table,
containing a reference to a field or primary key field in another table. A foreign key
specifies how to join tables. Of the two are logically related tables called a primary
key table or the master table and another table of the secondary (outer) key or a
subordinate table. Database allow us to compare the related records from both tables
and bring them together in the form of a report or request.

There are three types of primary keys: the key fields of the counter (counter),
and simple key composite key.

Counter field (data type counter). field data type in the database, where each
record added to the table in the field is automatically entered a unique numeric value.

Simple key. If the field contains unique values, such as codes or part numbers,
then this field can be defined as the primary key. As a key, you can specify any field
that contains the data if the field does not contain duplicate values or Null.

Composite key. In cases where it is impossible to guarantee the unigueness of
the values of each field, it is possible to create a key that consists of several fields.
Most often such a situation arises for the table that is used to connect two tables with
a many-to-many.

It should again be noted that the primary key field should be only unique
values in each row of the table, ie match is not permitted, and in the secondary or
foreign key values match lines permitted in the table.

If you are having difficulty with the choice of a suitable type of the primary
key, as the key is advisable to choose a field meter.

Programs that are designed to structure the information, placing it in the tables
and data manipulation are called database management systems (DBMS). In other
words, the database are designed to create and maintain a database and data access.
Currently, there are more than 50 types of databases for personal computers. The
most common database types are: MS SQL Server, Oracle, Informix, Sybase, DB2,
MS Access, etc...

3. Create a database. design Stages

Creating a database begins with the design.

Stages of database design:

1. Investigation of the domain;



2. Data Analysis (entities and their attributes);

3. Defining relationships between entities and the definition of primary
and secondary (external) keys.

The design process is determined by the structure of a relational database
(tables structure, their structure and logical connections). The table structure is
determined by the composition of the column, the data type and size of the
columns of the table keys.

By the basic concepts of database model "entity - relationship™ include:
entity relationship between them and their attributes (properties).

Essence - any concrete or abstract object in the subject area. Essence -
this is the basic types of information that are stored in the database (table in a
relational database is assigned each entity). For entities may include: students,
customers, departments, etc. A copy of the nature and type of the essence - it is
a different concept. The concept of an entity type refers to a set of
homogeneous individuals, objects or events, acting as a whole (eg, student,
client, etc.). entity instance includes, for example, to a particular person in the
set. The type of entity can be a student, and a copy of - Petrov, Sidorov, etc...

Attribute - this property is in the nature of the subject area. His name
must be unique for a particular entity type. For example, the essence of the
student the following attributes can be used: name, surname, patronymic, date
and place of birth, passport data, etc. In a relational database attributes are
stored in the table fields.

Communication - the relationship between the entities in the domain.
Links are connections between the parts of the database (in a relational
database - a connection between table entries).

Entity - This data, which are classified by type and communications
show how these types of data are correlated to one another. If you describe
some subject area in terms of nature - communication, we get the entity-
relationship model for this database.

3. Microsoft Access 2007.

The application Microsoft Access 2007- This desktop relational database
management system (RDBMS), designed to work on a standalone personal
computer (PC) or a local area network that is running Microsoft Windows
family of operating systems.

Database Microsoft Access 2007 provides powerful, convenient and
flexible means of visual design objects with the help of wizards that enables
the user with minimal surface preparation pretty quickly create a complete
information system at the level of tables, queries, forms and reports.

The main features Microsoft Access 2007 database include the
following:



* Design of basic facilities - two-dimensional table with fields of different data
types.

* Create relationships between tables, with support for data integrity, cascading
updates fields and cascade delete records.

* Entering, storing, viewing, sorting, changing, and sample data from tables by
using different means of controlling information, indexing tables, and the algebra of
logic device.

» Creation, modification and use of derived objects (queries, forms and
reports).

In Microsoft Access 2007 database, you can create:

» Table - two-dimensional table, which is used to store data in relational
databases. The data is stored in the records, which consist of individual fields. Each
table contains information about entities of a certain type (eg, students).

* request-tool for the selection of data that satisfy certain conditions. Since only
necessary information can be selected from the database using queries

* Shape - a tool that simplifies the process of entering or changing data in the
database table that provides data entry staff low qualifications.

* Report- tool that allows you to extract from the base of the right information
and present it in a form convenient for perception, as well as prepare a report to be
printed, which is decorated accordingly.

» Pages - the data access page is a special Web-page that is used to view and
work on the Internet or intranet data that is stored in Microsoft Access databases or
database MS SQL Server.

» Macro - set macros created by the user to automate certain functions.

» The modular object containing Visual Basic program in the language used in
some cases for data processing.

MS Access 2007 user interface - is a program that implements a dialogue in the
process of the user with the Access 2007 application.

When you run Access 2007, the application will be displayed new home page
Getting Started with Microsoft Access 2007
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Pic. Home Getting Started
with Microsoft Access 2007

When you create a template-based database, you can select the desired
pattern on the page Getting Started with Microsoft Access 2007 from the
category templates or templates from Microsoft Office Online.

To create a new empty database, you must click on the icon Blank
Database under New empty database, the right of the application window will
appear a text field with the file name: Database dannyhl.accdb and folder icon
to save the file to the desired directory. By default, the file name, directory
name, and the disk where the file will be saved. The file name, directory, and
disk storage file can be changed. It should be noted that Access 2007 for new
default database uses the Access 2007 file format (.accdb).

After selecting the folder, disk, file, and database formats, you need to
click on the New button. The database file with the selected name will be saved
in the specified folder, and open Microsoft Access 2007. This window is the
application window displays the Database window with the assigned name on
the Mode tab and the new table is empty table named Tablel in Datasheet
view. Next, go to the Design mode and create the structure of the first database
table.
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Pic. Tools and Microsoft Access 2007 window.

Consider Microsoft Access 2007. application window In the top part of the
window: Office Button, the Quick Access Toolbar with icons (save, undo), title bar
buttons and window resizing.

Below is a belt, which consists of tabs (Home, Create, External Data, working
with databases and other tabs, which appear depending on the operating mode). In
Access 2007 application apply contextual tools that appear when working with a
particular object. For example, when working with the table appearing contextual
tools for object Table titled Working with tables that have two tabs: Datasheet and
Design.

On the Ribbon displays specific commands sets depending on which tab is
selected. Groups of commands on the selected tab are grouped by workflow. So tab
displays the mode tables group commands View, Fields and columns, formatting, and
data type Link. The names of the listed groups of commands are displayed at the
bottom of the tape.

Under the belt are located on the left navigation pane, and the right of editing
window that displays an editable object. In the navigation pane contains all the
Access objects (tables, forms, queries, reports, etc.). In the All Access objects you
can select the desired object. When you double-click on the object name in the
navigation pane, this object will be displayed in the editing window. Access the
bottom window is the status bar and buttons display modes.

5. Create a database (tables and relationships between them) in Access 2007
Create a new database under the name of the emergency room.
When you create a new empty database Access 2007 application window
opens on the contextual tab mode table. The window displays a new empty table
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Pic. The new empty table.

Next, go to the Design mode and create the structure of the first database table. To do
this, click on the icon and choose View Designer mode.
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Saving window opens in which to specify the name of wounds and click OK.
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Pic. Save dialog box

Open Wounds table in the Design view
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Composition (structure) of the table defined in the project table that has
three columns:

* The field name;
* The data type;
* Description.

Data types must be selected from the drop-down list:



* Text - alphanumeric data (up to 255 bytes)

* Field memoran- long text or numbers, such as notes or descriptions (up to
64,000 bytes)

» Chislovoy- text or combination text and numbers (stores 1, 2, 4 or 8 bytes)

* Date / Time - the date and time (8 bytes)

» Denezhnyy- used for monetary values (saves 8 bytes)

» Counter - automatic insertion of unique sequential (incremented by 1) or
random numbers when adding entries (4 bytes)

» Logical - data, taking only one of two possible values, such as "Yes / No" (1
bit)

» Field object OLE - to insert the following objects: drawings, pictures,
diagrams, etc. (Up to 1GB)

» Hyperlink - address links to a file on a standalone computer or network
(stores up to 64,000 characters)

» Master podstanovok- creates a field that allows you to select a value from
another table or from a list of values using a combo box. When this option is selected
in the list of data types, a wizard for automatic determination of the field.

In the field of properties designate the properties for each field (for example,
size, format, an indexed field, etc.).

When you create the first column of the table structure of the input field name,
then you must press the Enter key, and select a data type. Then type in the third
column of the field description.

Create a table structure wounds. Injury Table contains two fields: View and
KodRany wounds. In the first column row Field Name, enter ID Wounds (KodRany)
and press Enter. The cursor moves to the column data type. Access assigns a default
data type -Schetchik. Press the Enter key, the cursor moves to the column
Description, enter the description of the data, if necessary.

The first line of the table (KodRany field) Access by default assigns the
primary key field. For a primary key field in the properties is set to be indexed fields:
Yes (Coincidences are not allowed). Next, fill the second row (the second field in the
table), the field name - view of the wound, the data type - text.
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Pic. Table Wounds

Then create a second table structure Patients. Patients table includes five
fields: KodPatsienta, Last Name, First Name, Date and Type of wounds.

It should be noted that the structure of the table for the field of view of
patients wound (secondary key) to set the value of the indexed fields: Yes
(Coincidences are allowed) and the type of data the Wizard substitutions.

When choosing a data type Lookup Wizard, Wizard called substitutions
and a dialog box opens B
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Pic. Dialog Creation substitution.

In our case, in this window you need to select Object "column of
substitution™ (to use the values from a table or query) and click Next.



The next step is to select an object from which the data will be selected. In this
case, we choose a table wounds.
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Pic. Selection table for a substitution.

Next you need to choose which values are displayed in the column substitution.

For our table just select the field type wounds
6. Set the logical connections in the Access 2007 database.

Logical connections are established between the same database fields Access
2007. Data Communications data tables in one table with data in other tables through
a unique identifier (key) or key fields. In our case, we need to set up logical links
between tables: Wounds and patients.

To establish connections using a key field KodRany. For example, between the
primary key (KodRany) Injury table and the key secondary (wound type) Patients
table set up one-to-many.

Before creating logical connections should be in the edit window to close all
the table and go to the tab Working with databases. Then click on the icon of the data
scheme in the edit window will appear active dialog box Adding a table against the
background of an inactive window data scheme.
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Pic. "Adding a Table" dialog box.

In the Add tables necessary to select table names and click the Add
button, all tables will appear in the data scheme. After that you need to close

the dialog box.
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Pic. Window data scheme.

When using the Lookup Wizard relationship between the respective
fields of tables created automatically. Next, you need to click on the link, right-

click and select Change Us ... As a result of this operation will be a window
Changing relations.
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Pic. The dialog box Change Association.

In the resulting dialog box, Change the links you need to install the boxes: To
ensure data integrity, cascading updates related fields and cascade delete related
records to ensure that the set type of relationship one-to-many, and then click Create.

After installing the relationships between tables, you must close the window
scheme data. Next, you need to carry out filling all the tables. Filling it is advisable to
start with the wounds of the table as a field KodRany Wounds table is used as a
substitution column fields table wounds of the patient.

7. Filling of the Access 2007 database tables.

Tables DB Access 2007neobhodimo fill data in a certain sequence. First, you
need to fill in the main table, and then subordinates.

The drop-down list of data for secondary keys only appear if when you create
the structure of tables in the slave mode, the constructor for the fields of secondary
keys selected data type Lookup Wizard.

Consider filling the wounds of the table. In the Database window in the
emergency room facilities choose Wounds table, and execute on it, double-click. The
editing window will appear Wounds structure table in Datasheet view. The new table
consisting of a single blank line.

Filling is done through the records (the rows). Counter Field (KodRany field)
is filled in automatically. Move to the next field by pressing the Tab key. After
entering the first record cursor moves to the next record. After filling the wounds of
the table is as follows.
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Pic. The completed table Wounds

Similarly, the table is filled Patients. It should be noted that in the table
Patients Field filled wound type drop-down list.

Bce Tabanuel >l & | = l'lalweﬂ1hl""-_\

Pahbi % HCI,D,rlaLI,IAEH'-v Qamuana - Mma +| OrtuectBo ~ [fatanoctyr ~ | BugpadHbl - JoBasume none
=1 Panbi: TaGnuua 1 Xybynos Kasben MeTposuy 25.03.1998 Pe3aHaA

MaumeHTs P 2 MNetpoea 3mMHanga AnexceesHa 05.06.1990 KonoTaa

= MaLMeHTE : TaBit., ¥ 3 3aceesa daTuma ApTypoBHa 02.12.1994 |Z|
* (Ng)

Pic. Students completed table.

It should be noted that in 2007 Access databases are various methods for
moving the table. Transitioning from record to record, you can use: arrow keys;
Record buttons from the area, located at the bottom of the table in Datasheet
view; Goto Find the group, located on the tape. To move from field to field
(left to right) used the Tab key and Enter, and in the opposite direction Shift +
Tab.

Search data in the table a large amount, it is possible to carry out search
team located at the bottom of the table in Datasheet view, or click Find to find
the group, located on the tape. To change the data fields you want to use, click
Replace in the Find group, located on the tape.

3. The purpose of activity of students in class:
The student should know:
1. The main structural elements of the database interface Assess.
2. Basic terms Assess.
3. Stages of database design.
4. The principle of operation of the database.
5. How to enter information, create tables.

The student should be able to:

x
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. Design Databases.

. Work MS Access 2007.

. Create a database.

. To present data in tabular form.

. Identify the key fields.

. Create a multiple-database.

. Learning content:

. Concepts Databases

. Basic concepts of relational databases:

normalization, communication and keys
2.1. The principles of normalization:
2.2. Types of logical connection.

2.3. Keys.

3.
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Create a database. design Stages

4. Microsoft Access 2007.
5.
6
7

Create a database (tables and relationships between them) in Access 2007

. Set the logical connections in the Access 2007 database.
. Filling of the Access 2007 database tables.

. The list of questions to test the level of knowledge:

. What is the Databases Management System database?

. What is MS Access 2007?

. The main elements of MS Access 2007 working window?

. The list of questions to check the final level of knowledge:

. What is a database?

. What is MS Access 2007?

. List the basic MS Access 2007 features.

. Describe the working window Microsoft Access 2007.

. Define the table, normalization, communication and keys.

. Give the definition of the essence, attributes and domain.

. Describe the kinds of logical relationships. What are they installed?
. What is the key. Describe the kinds of keys.

. List the steps of database design.

10. Main features of the database MSAccess 2007.

7.

To study the theoretical material, examining all the examples in it the solution of

typical problems.

1.
2.

Create an Access database.
On the basis provided in the embodiment of the job description of a database to

create a table. Names created tables must match the names of the tables (entities)
listed in the job variant.



3. In each table to create a field. The names of the fields and their data types must be
appropriate to the description in the embodiment.

4. Create relationships between tables in accordance with the assignment plan. In
addition, for each link to install support for data integrity.

5. Create a lookup field in the tables where appropriate.

Check the database schema: make sure that the diagram shows all tables and relations
between them.

Option 1

Dana fragments of database tables. Create a trauma center database and fill in data.

Where required, create a lookup field for the convenience of filling tables.
Wounds



Topic 6: ""Standard software. Presentations in MS Power Point environment.
Interface, the main elements and options for the solution of health problems **

1. Scientific and methodological support of the theme:

Microsoft PowerPoint program - a powerful and at the same time quite easy to
learn tool for creating electronic presentations designed to visualize the work of the
artist (or artists group) attention of other people.

The presentation consists of successive frames called slides. Each slide
contains various types of information: text, images, audio and video files.

2. Brief theory:

1. The concept of presentation and slides

A PowerPoint presentation called Documents. Any PowerPoint document is a
set of separate but interrelated frames called slides. File usual presentation Microsoft
PowerPointimeet extension .pptx. In the process of creating presentation slides can
rearrange, delete, add new ones or just change the content of existing slides.

Presentation - way of presenting information. Multimedia presentation created
to support the report, and should be, above all, informative. Information should be
presented in the most vivid and convincing manner. For this purpose, graphics, video
and audio information. The main ideas are reflected in the text fragments. They are
usually small.

Although PowerPoint is has its own means to create objects of different types
(text, tables, graphics, etc.), thanks to the tight integration with other components of
Microsoft Office, the user is able to use already tried and tested materials. For
example, text can be prepared in the text editor Word, the formula - in Microsoft
Equation application tables - into Microsoft Excel spreadsheet application, the chart -
in Microsoft Graph application, art titles - in Microsoft WordArt application.

Obvious advantages of electronic presentation:

 The sequence of presentation.

With the help of slides, replacing each other on the screen, hold the audience's
attention is much easier. Unlike conventional slides, passed through an overhead
projector, screen presentation allows you to quickly go back to any of the questions
already examined or even change the order of presentation;

« Ability to use the official cribs.

Presentation - this is not only what the audience sees and hears, and notes for
the speaker: what not to forget how accents.

» Multimedia effects.

Slide presentation - not just an image. As there can be elements of animations,
audio and video clips. They are able not only to significantly beautify the
presentation, but also enhance its informative value.

* copied.



Copies of electronic presentation are instantaneous and do not differ
from the original. If desired, each listener can get your hands on all the
materials shown.

* Portability.

CD with presentation compact. In addition, the presentation file can be
sent by e-mail, published on the Internet.

2. Types of presentations

* The presentation of the scenarios (for WEB-pages).

* Interactive presentations running under user control.

« Continuously running presentation.

Presentations can have different objectives. In line with this are the
following types of presentations:

* Business and marketing presentations.

* Educational presentations.

« Support of research reports.

3. Steps for creating presentations

Stage 1

First you have to understand what you are going to present itself?

Demonstrate you can create a presentation on a computer monitor, on a
projection screen in the Internet Web-page as well as through transparent
banners or standard 35 mm slides.

Stage 2

Once you have decided, then what you actually want, it is necessary to
outline the general presentation of the plan, then:

Firstly, you can easily calculate how much you need to create slides.

Secondly, you will see clearly, with a slide on which you will move. For
example, during the slideshow, you need to go back to the previously shown
slide or give a choice of transition from one slide to another ...

Third, you will clearly understand whether you fit the standard slide
layout or you will have to make their own.

Fourth, you will realize that you need to prepare in advance - what
pictures, what music, etc. you may need ...

Fifth, you will be able to find their way in the selection of animation
effects.

Stage 3

Directly editing and layout slides. That is, the content of the slide text,
add the necessary images, tables, charts ...

Step 4

Adding multimedia effects - sounds, animation setting. Setting
interactivity - working with the control buttons, creating and configuring
hyperlinks.



Step 5
Check the presentation performance. Packaging for transport to the place of
presentation or printing.

4. The main elements of MS PowerPoint 2010 program working window.
So, open the PowerPoint program and look at the main elements of its

interface:
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Pic. PowerPoint program window

In PowerPoint 2010 window provides the following elements:

» Window title bar containing the name of the file;

* Quick Access Toolbar, which are located most frequently used commands
Save, Undo and Redo. At its discretion, you can add or remove teams, included in
this list. Simply click on the drop down menu with additional set of tools, and select
the desired;

* Feed with tabs - one of the main elements of the PowerPoint interface. The
tabs contains all the tools necessary for the manipulation of the slides;

* the editing area of the slide - the main part of the window, which will be
carried out all operations on the presentation;

* scrolling line, via which the movement in the presentation;



 Status bar - located in the lower left corner of the document and
contains basic information about the current slide: slide number, subject,
language;

 adjustment of the scale of a slider with which you can increase or
decrease the scale of the presentation in the workspace;

Fit slide button in the current window. With this function you can
arrange the slide so that it was completely visible on the screen without
scrolling slide further;

» Slide show mode button. Switching between them changes the
presentation on the screen: the normal editing mode, slide sorter, a
demonstration in a separate window, and display mode.

5. The default mode NORMAL

Now consider the default Normal mode settings, in which all the basic
steps in the initial phase of creating a presentation. When operating in this
mode, the screen is divided into four areas:

« the editing area of the slide;

* Notes to the slide area;

o Slides tab;

* Structure tab.

PowerPoint presentation - a set of slides on which you place various
types of information: pictures, diagrams, sound files. As you have seen, the
slide - the main element in PowerPoint, with whom you will work directly.
Open a new PowerPoint document editing area, you will see the title slide. It is
usually placed general information about the entire presentation: title, author's
name, the time and place of creation and so on..

Data is entered in the Title field and the slide in the slide subtitle. As a
rule, each slide should have only the main points or footholds presentation.
Any PowerPoint presentation implies clarity and simplicity, so do not overfill
the slide text information. Additional information better inform orally during
the presentation of the report or in the form of handouts, printed for the
students.

In the notes to the slide, you can enter the necessary information for each
slide individually. Audiences these notes will not be visible, and you, in turn,
do not forget any details would be reported.

On the Slides tab on the left side of the window as thumbnails displayed
a small copy of the slides that make up the presentation. This allows you to
quickly navigate to them, delete or add a new slide.

Click on any slide, and it immediately appears in the editing area in the
center of the screen. On this panel, you can easily move between slides, as well
as to change their position. To do this, simply click on the slide and hold the
left mouse button, drag it to another position.

6. Work with tabs



Ribbon with tabs located along the top of the screen below the title bar,
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Pic. Ribbon with tabs

Immediately after the launch of the program at your disposal will be ten tabs,
which are located all the tools you need to work with slides:

* File;

* Home;

* Insert;

* Design;

* Transitions;

* Animation,;

* Slide Show;

* Review;

* View;

* Settings.

PucosaHue « | PegaktuposaHue

Consider the major ones.
6.1. The File tab

On the File tab is a standard set of operations performed with the file in
PowerPoint.

Use the controls on this tab you can:

* learn the basics of the presentation file in the Details section: who and when
created, size, number of slides, etc .;.

» Keep finished presentations in the selected folder on your computer's hard
drive using the Save or Save As;

* close the presentation team close and open the command Open, indicating
that opens in the Open dialog box the path to the appropriate file;

 The last section to view the presentation, on which work was carried out in
recent years;

« Create presentations from templates and themes suggested in the Create;

. print the presentation, after setting the print settings in the print;

. save presentations with certain parameters and perform other operations
using the controls, see Save and Share
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Pic. Print Settings tab Settings File

Also, you can access to reference materials, the parameters of the
program and complete the work with PowerPoint 2010.

6.2. Home tab

Home tab contains the elements of creation and formatting of objects:
slides, sections of text, graphics, lines, labels, various geometric shapes, etc.
When you start the PowerPoint program and opening the default presentation
file Home tab is active..

Use the controls on this tab you can:

* create a new presentation slides by clicking the Create a slide or slides
to add a certain structure, using the arrow button under the Create a slide and
selecting the layout of the proposed set;

» perform cut, copy and paste objects from the Clipboard group controls.
Perform a quick format on the model for all slide text elements: positioning the
pointer over the sample and click the Format button on the model, select the
desired portion;

« organize the slides in sections by clicking sections, creating a whole
presentation of the structure and thereby emphasizing each thematic area of the
report;

perform text formatting: set the desired font for the slide titles, or a
paragraph, change alignment, add drop shadows, as well as to give the text list
view with the help of groups of elements font and paragraph;




« insert into the slides figures, such as rectangles, circles, lines, arrows, callouts
formula or by selecting them from the list in the group drawing and formatting. These
graphics give visibility speaker speech, make it more interesting, and also allow the
design to adhere to the entire presentation in the same style. Use the Quick Styles
button, you can select a suitable fill shapes. Arrange button allows you to distribute
the slide several shapes, group them into a common graphical object for ease of
movement and other operations;

« to search for the desired slide in the presentation by introducing a
combination of letters or phrases in the box caused by clicking Find, and perform text
replacement and allocation

6.3. Insert tab,

On the Insert tab, the controls are arranged to insert all the necessary structures
which gives clarity in the presentation speech speaker and allows the listener to get
the most complete picture of the subject disclosure.

Use the controls on this tab you can:

« add to the slide table, specifying the desired number of rows of columns by
using the button Table;

* placing images: drawings from the file, pictures, screen shots, photos;

* create your own photo album by creating a wizard, called by clicking the
album. In the image, you can choose the necessary dialog box, from the hard disk,
place them in the correct order, add a signature, select a layout and perform other
settings;

* add illustrations in the form of figures of presets, SmartArt graphics or charts.
It should build on the goals, which will serve as illustration of the data. This may be a
block-diagram representation of a visual simple list or chart showing a comparison of
certain data;
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" Pic. Example of inserting images in the slide by using the Insert tab tool

add links in the presentation and active regions, as well as special

characters;

e insert such informative text elements such as date and time,

descriptions, headers, footers, etc. They are combined into a group text..;

+ add multimedia objects to a presentation by choosing Video and Sound.

In this case, you must specify the path to the file on the hard disk or select it
from the Office Online resource collection.

6.4. tab Design
Design tab is designed to develop the overall presentation of the concept:

the selection of the most appropriate general style, color schemes for a slide,
composition.

Use the controls on this tab you can:
» select suitable PowerPoint presentation themes designed by

professional artists and designers. To try this or that subject, move the pointer
on the appropriate thumbnail in the collection (Group Topics) and pay attention



to how to change the appearance of the document. Assigning a new theme leads to a
change in the fundamental properties of the document: headers, tables, charts, shapes,
and other objects. .. The combination of colors, the general background, the object's
fill, font, text, etc. kept in the same style;

. use the built-in themes as the basis for creating your own. To do this,
select a theme, it is sufficient to change the existing or set new parameters: colors,
fonts, effects, background style, etc. Then you can save the settings as a new theme in
the collection, select the Save current theme in the list of the thumbnail;.

. Select the size of the presentation slides when preparing to print, set the
offsets from each end using the Page Setup command;

. change the location of the slide on a sheet by typing the slide orientation;

. manage the background properties.
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Pic Changing the design of a presentation using built-in themes
PowerPoint Design tab




6.5. Transitions tab

In Transitions tab contains tools to configure a smooth transition effects

between slides, allowing to capture the viewer's attention.
Use the controls on this tab you can:

* Select your favorite transition effects presented in the group go to the
slide. Previous slide can gradually dissolve, giving way to the next, the frames
can be changed each other with a shift from the bottom or in the form of a
certain movement pattern (cube, clock hands, opening doors, and so on. D.). To
access the entire collection of effects, you need to click on the button. The
selected effect is applied to the current slide, but it also can be assigned to all

slides in the presentation by using the button Apply to all;
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Pic. Collection tab effects Transitions

. view and set parameters for the selected effect by clicking Effect

Options. Quick view the effect on the slide is done by clicking on his name;

* connecting to the slide audio files using the Sound drop-down list.
When you click on the appropriate button opens a list of sound effects from the



Microsoft Office Collection. audio playback is performed when the mouse pointer on
its name;

* customize the duration of the transition effect with the input fields with the
meter length. To do this, simply enter in this field the desired value from the
keyboard, or increase / decrease the value using the buttons;

* a way to define slide transition on the screen during the demonstration. If you
check the On Click, then the transition to the next slide will be performed at the click
of a mouse. If you check after and specify the time interval between slides, the
transition will be carried out automatically;

 Perform viewing the current slide, click the Browse button. This function
allows you to play in the work area of the slide being subjected to the transition effect
and sound.

6.6. Animation tab

Items located in the Animation tab, enable prepodnosimye make the material
more lively and intense. Animation Schemes - is embedded in PowerPoint ways that
define the appearance of content on the slide screen during the demonstration
presentations.

Use the controls on this tab you can:

» opt for the selected objects on the slides animation scheme from the samples
provided in the list of styles of animation. For example, the title of the slide can fly in
on a slide, picture may appear to the rotation, the individual list items -.. Acquire
transparency, etc. To open a collection of effects, you need to click on the button
animation style, or use the Add button animation. The effects are grouped by type
appear on the screen: Entrance, Emphasis, Exit, traverse paths. To open the additional
effects of the same type (for example, the entrance effects) is sufficient to execute the
command Styles animation — Extra entrance effects. In this case a window opens
with an extended list of effects;
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Pic. Change login dialog box effect

« view and set the parameters of the selected effect by clicking the effect
parameters. Quick view the effect on the slide is executed when the mouse
pointer on its name;

» change the method of starting the animation duration, pause, next start
in the group slide show time;

* display / hide the bar field of animation, useful during rehearsals and
presentations at work with a lot of effects;

« view the animation effects of the current slide by clicking the View tab
in the animation or animation. When viewing all of the effects in the order
established for them are displayed in the workspace window.

It must be remembered that you should not overload the separate
presentation of various special effects. Especially if it reveals any specialized
subject of professional activity of the company. It suffices to use one or two
effects to logically separate steps presentation. Caution viewers in this case
should focus on the theme of the material presented.

Using more useful when demonstrating effects photos, panoramas and
colorful images, since it makes viewing fun and exciting, and the presentation -
bright and catchy.



6.7. Tab Slideshow

Slide Show tab contains elements designed to view your finished presentation

in full-screen mode, and perform the necessary preparations for the show.
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Use the controls on this tab you can:

« start slide show from the first (title) slide by pressing From the beginning to
check all submitted in the presentation material, a general impression, notice errors
and vague language to see whether in order properly placed slides observed whether
their logical sequence and .. etc. slide Show can also be run with an open window in
the working team of the slide from the current slide;

* set the parameters to display a dialog box, the local team demonstration
Setting: specify the type of display control slides that you want to demonstrate a way
to the slide show, the color of the laser pointer, etc .;

* hide selected slides by choosing Hide Slide. This feature allows you to leave
a significant slide in the overall presentation of the structure, but did not include them
in the demonstration;

* Record the time that will be spent on each slide demonstration. To do this,
use the command time setting, helps identify too simple slides or information
overload, as well as to determine the time needed to explain each slide (if the
demonstration commented rapporteur);

* change the screen resolution by selecting the desired value in the Resolution
drop-down list.

6.8. tab Review

On the Review tab located control elements for the review and implementation

of additional operations on a presentation.
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Pic. tab Review

Use the controls on this tab you can:

» check the spelling using the Spelling tool

» replace the incorrectly-sounding concepts similar in meaning synonymous via
Thesaurus- function is to avoid repetitions and fuzzy formulations;



» Use a built-in interpreter (Translation team), without resorting to the
opening of additional dictionaries. This function can be performed for the
translation of the selected text, and for an instant translation of the word /
phrase in a tooltip;

* add notes to the text objects by selecting Create a note and move on to
the next / previous note. These features can be extremely useful when working
with presentation of several authors or reviewers;

» compare and merge presentations version with the command Compare.
After the merger of the procedure on the right side of the working window
displays the scan area - Corrections panel, which will present information
about all the differences found: removing and adding slides, drawings and
other objects, as well as changes in the text.

6.9. View tab

View tab contains commands with which you can change the viewing
modes of presentation, configuration samples, as well as the team, causing the
auxiliary tools for optimization of multiple PowerPoint files at a time.
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Use the controls on this tab you can:

» Slide to change the current display mode: Normal, Slide Sorter, Notes
Pages, reading mode;

» use and create design patterns: Slide Master, Handout Master, Sample
notes;

» display additional elements to align objects on the slide: the vertical
and horizontal lines, the grid guide. To do this, check the appropriate boxes;

» establish convenient scale display by choosing Zoom and Fit to
window;

* set color gamut slides by one of the following: Color, Grayscale, Black
and white. This feature is useful when you want to print color presentations on
a black and white printer;

* organize representations for open files, PowerPoints commands group
window;

* open a list of macros for their implementation, creation and deletion by
clicking Macros. Macro is used for automation of work and at the same time is
a set of commands and instructions.



7. Slide show

In the program there are PowerPoint slides view modes: Normal, Slide Sorter,
Notes Pages, Reading Mode.

To go to any of these modes, on the View tab, click one of the buttons in the
group view the presentation modes. Depending on the mode change window view
presentation and layout of its basic elements. View Modes are designed for a more
comfortable working with the slides at different stages of the presentation.

Normal - this is the main mode in which you create and edit all of the slides
that make up the presentation. In this mode, you are working with each slide
separately: enter text, insert images, graphs, tables.
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Slide Sorter - This mode is useful for editing a finished presentation. Turning to
him, you will see on the screen all the slides in the order in which they appear on the
screen when presenting the presentation. In the lower left corner of each slide under
the specified sequence number.

In addition, in this mode it is possible to assess whether in the style of a feature
slides, slides combine thematic groups by adding a partition function, see the effects
of transitions and animations, as well as learn a demonstration of each slide
(animation icon appears under the slide).
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Pic. Demonstration in Slide Sorter

Note pages - mode for printing handouts with the author's notes to slides.
These notes can be added to fit the slides as you edit the presentation in normal
mode, or make notes on this page, in the top half of which displays a thumbnail
of the slide, and in the lower part shows the area equal in size to the slide notes.

Reading Mode - in this mode is performed to demonstrate the
presentation in a window managed user: Displays the title of the program
window and the status bar.

8. Creating a Presentation

8.1. Create a new presentation

Creating a presentation with a completely clean slate means to develop
their own original project using PowerPoint software tool using a creative
approach to the process.

This option is the most time-consuming because you have to create their
own slide, they have a variety of objects, to think through the entire structure of
the presentation and its design.

To create a new presentation, follow these steps.

1. Open the File tab, and then click Create in PowerPoint 2010.



2. Select the new presentation, and then click Create.

A new presentation is created automatically, and when you start PowerPoint
2010 program.

In the central part of the window displays a simple slide that contains the
following service elements:

* Slide the title;

* subtitle slide.

Below is a window to the slide notes.

This slide is the title slide of the new presentation, which specifies the name of
the presentation and explanatory information, such as speaker name or company
name.

To enter the information on the title slide.

1. The slide displayed in the central part of the window, click on the title of the
slide labels, and enter the name of the presentation, such as "APM Doctor."

2. Click on the slide labels Subtitle and enter additional information.
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Pic. Title slide

At the top of the window is a tabbed ribbon tools. The whole central part of the
window is occupied by the current slide image. On the left is a list of slides that make
up the presentation. This area is called, as we have said, the slide panel and can be
represented by a thumbnail slide (Slides tab) or in the form of the document structure
(Structure tab).

8.2. Add a slide
As mentioned above, a new presentation initially contains only a single title
slide. Slide you can add to your presentation in two ways.
Method 1: On the Home tab is the command Create a slide, which is a double-
button drop-down list.



1. Click on the upper part (icon) creates a new slide using the default
layout.

2. Click on the bottom part (the name with an arrow) opens a menu
containing a list of built-in standard PowerPoint layouts

2010 and additional commands. slide layout determines the layout of the
alleged members of the current slide (the main text, bulleted lists and headings,

tables, charts, graphics, sounds, movies, pictures, and so on. d.). Select the
appropriate layout.
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Pic. Selecting the layout for the new slide

Fig. Selecting the layout for the new slide

Method 2: On the Slide pane, set the pointer to the position where you
want to add the slide, right-click and select New slide.

You can change the slide layout, and after it is created. To change the
layout of the current slide, do one of the following:

* On the Home tab of the ribbon, click Layout, select the gallery to
uncover the appropriate occasion slide layout and click its thumbnail;

* panel slides open the context menu for the desired slide, click Layout,
and then the appropriate option.



8.3. Placing objects on the slide

When a new presentation already has a number of slides, you can start filling it
with material. Adding objects on the slide can be carried out with the help of teams
tapes after using fillers placed in the slide layout.

The layouts can be arranged following text and object placeholders:

* text;

* drawings;

* Picture SmartArt;

» The screen shots;

* diagram,;

* tables;

* scheme;

» multimedia clip;

* Pictures;

* films;

* sounds.

All built-in slide layouts (except the Blank slide layout) contain aggregates
content.

Text placeholders are displayed as dotted rectangles with a title slide or a text
element. Clicking on an inscription activates input field values. Type or paste the text
you want from the clipboard.

The object placeholders are displayed as dotted rectangles with icons object
(table, chart, Smart-Art drawing, drawing from a file, picture, multimedia clip). For
example, if you want to insert a slide image from a file, click on the icon

Insert Picture From File brings up a dialog box for specifying a file stored on
the hard drive or removable media. If you want to add a picture, click on the icon will
open an additional picture area to search for images contained in the library of
Microsoft Office clips.

To add an object to the slide with the help of tools tape, follow these steps.

1. On the Slides pane, select the slide you want to add an object

2. Click on the control tape on the Insert tab, and then click to insert the desired
object:

« if you want to add a text box, click on the item inscription, the mouse pointer
on the slide label its location and boundaries, then type or paste the text from the
clipboard,;

» If you need to add a picture from a file, click on the element of Figure, in the
dialog box, select the folder, select the image you want and click Insert.
Alternatively, you can open the presentation of the current window at the same time
and a Windows Explorer window, find the desired image in Explorer and drag it to
the Stage presentations, hold down the left mouse button;

« for the selection of a graphic image, you can use Microsoft Office library of
clips. To do this, click on the picture elements, which opened in the Search field, type



in a keyword or phrase, and then click Start. Will be presented images that
match the search parameters. Click on the appropriate thumbnail and the screen
will be placed on the slide.
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Pic. Insert a text box into a presentation

The dimensions of an object on a slide, you can change.

1. Click on the object.

2. Move the mouse pointer to any marker on the object frame. The pointer
becomes a double-headed arrow.

3. Hold down the left mouse button, drag the cursor, watching the changing
dimensions of the object.

To rotate an object on a slide, follow these steps.

1. Click on the object.

2. Above the frame of the object appears green anchor marker. When you
hover the mouse pointer cursor changes to a circular arrow. Hold down the left
mouse button, do the roundabout.

3. The object will rotate synchronously. When he takes the desired
position, release the mouse button.

Change the position of the object on the slide can be as follows.

1. Click on the object.

2. Move the mouse pointer to an object (or boundary inscriptions) in any
place (except the markers), and the pointer changes to a crosswise direction of
the arrows.

3. Drag the object, hold down the left mouse button. The movement of
the object is accompanied by a picture frame, or translucent.



4. When the object will take the desired position, release the left mouse button.
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Pic. Changing the position of an object on the slide with the mouse

You can change the order of multiple objects inserted on the slide, so that they
partially overlap each other:

« If an object should be placed above another object, click on the right mouse
button and on the shortcut menu, click Bring to Front Move — forward;

« if an object must be placed in the foreground with respect to all other objects
in a slide, click on the right mouse button and on the shortcut menu, click — Bring to
Front to Front.

To delete an object, select it and press the Delete key.

9. Creating a presentation using the slides and samples
Presentations easy to create using the provided library of themes and slide
designs.

9.1. presentation Design

When you create a new presentation, you can immediately choose a built-in
theme determines the appearance of the document by using background colors, fonts
and graphics effects.

1. Click the File tab, and then click Create.

2. In the Available Templates and Themes, click the paragraph Themes.

3. From the options, select the appropriate button and click Create. The
window opens with a title slide of the presentation set design, and to all slides created
in the process, will be applied a common style.

Themes can be changed at any stage of work on a presentation, looking at them
in the gallery on the Design tab, in the Themes group. In addition, you can configure



specific settings of colors, fonts and effects and save them as a new theme in
the collection.

9.2. Setting the slide master
Another tool in the design of the project can serve as a mode of slide
samples. Slide Master allows you to make a schematic sketch of a future
presentation, picking up for her theme and simulated occupancy and effects of
elements on each slide in isolation.
To customize a slide master, follow these steps.
1. Click the File tab, and then select New — New — Create
presentation.
2. Click the View tab and click Slide Master in the group of samples
modes.
With the tools located on the tape of this mode, you can customize the
look of presentations and layouts that you use at work.
4. Click on the Themes button and choose from the collection of the registration.
The appearance of the slide in the work area changes when you hover the
mouse pointer over any topic. To apply a theme, click on it.
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Pic. Setting the slide master. Slide Master Mode
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An example of the slide is a slide at number 1 on the left side panel.
Under it displayed a slide layouts associated with the parent sample. All
models contain the same topic assigned to the model, but have a different



layout elements. If necessary, you can change the location of the elements in its sole
discretion, to add a beautiful figure, hats, posters, wallpapers and so on. N.

4. Click Close Master View and continue with the presentation in Normal
mode: you can add slides, using models and objects to fill the marked area,
formatting, styles to use express, add animation and transition effects.

Note that if the slide master is used after the creation of individual slides in a
presentation, some items may not correspond to a single style of design - to disappear
from view or to go beyond the boundaries provided for them markup (eg, footers or
logos should be configured in a master slide mode ). It is therefore recommended to
create a slide master before you start working with them.

3. The purpose of activity of students in class:

The student should know:

1. Appointment and PowerPoint software features.

2. What are the different kinds of presentations.

3. The steps of creating a presentation.

4. The main elements of the PowerPoint interface.

5. How to create presentations.

6. The process of creating a presentation using the AutoContent Wizard.

7. The process of creating a presentation using a design template.

8. Basics of slides (adding and deleting slides, change the order of slides,

change the slide layout).

The student should be able to:

1. Use of PowerPoint presentations to create opportunities.

2. Create a specific presentation of the structure and the form and give them the
best for the perception of appearance.

4. Learning content:
1. The concept of presentation and slides.
2. Types of presentations.
3. The steps of creating a presentation.
4. The main elements of MS PowerPoint 2010 program working window.
5. The default is normal.
6. Work with tabs.
6.1. File tab.
6.2. Home tab.
6.3. Insert tab.
6.4. Design tab.
6.5. Transitions tab.
6.6. Animation tab.
6.7. Slide Show tab.
6.8. Review tab.



6.9. Tab View.
7. slide show.
8. Create presentation.
8.1. Creating a new presentation.
8.2. Adding slide.
8.3. Placing objects on a slide.
9. Creating a presentation using the slides and samples.
9.1. Design of the presentation.
9.2. Setting the slide master.
5. The list of questions to test the level of knowledge:
1. What is PowerPoint program?
2. For what purpose are the presentation?
3. What are the advantages of electronic presentations in comparison with
other types of presentations?

6. The list of questions to check the final level of knowledge:
1. What is the PowerPoint presentation file, and which he has an extension?
2. Describe the process of starting and completion of the PowerPoint program.
3. List the elements of the interface of PowerPoint.
4. What are the different kinds of presentations in PowerPoint?
5. Describe the steps involved in creating a presentation in PowerPoint.
6. What are the different modes of viewing in PowerPoint? Describe them.
How to switch between modes?
7. What kind of objects can be placed on a slide PowerPoint?

7. Create a presentation
8. Independent work of students:

According to the textbook will learn the basics of creating a presentation in
PowerPoint.

9. Hronokarta training session:
1. Organizing the time - 5 minutes.
2. Monitoring of knowledge - 30 min.
3. Analysis of the theme - 20 min.
4. Practical work - 30 minutes.
5. Wrap-up sessions - 10 min.

10. A list of textbooks for the class:



1. AN Stepanov Computer science. Textbook for high schools. 4th izd.g.Spb, Peter.,
2006;

2. Esaulenko IE, Semenov SN Basics of practical informatics in medicine; VVoronezh
2005.



Topic 7: ""means the Internet to search for professional information on
individual sections of medical knowledge. Search engines™

1. Scientific and methodological support of the theme:

One of the main ways to find information on the Internet is search
engines. Materials for the placement of the web are preparing human beings, so
it is possible to find just what is published. Today on the Internet about two
billion pages. As a result, existing cataloging the web resources has become a
serious problem. Despite the fact that thousands of organizations involved in
cataloging, the problem does not come close to the resolution, and becomes
even more acute. The space is filled with Webbystree than systematized. Any
book begins and ends with the contents of the index. Content - is an example of
cataloging. The reader chooses a theme and find the page where the topic is
covered. Index - is an example of indexing. The reader will find in the index of
your search term and get the page number on which it occurs. On the Internet,
people are working on the catalogs and indexes are automatically generated.
When cataloging the resource experienced editor looks at it carefully,
determines which areas of expertise include the resource, establishes its
category in the industry and brings life to the catalog.

2. Brief theory:

1. The main types of search engines.

1.1. Search directories.

Search directories or Web directories (from the English. Web-directory)
appeared almost together with the birth of the Internet. Initially catalogs were
simple listing of links on a thematic or alphabetical principle. But as the
amount of resources it was clear that it was necessary to identify certain basic
headings, and subheadings to them and in which it would be possible to place
not only the existing sites, but also to add new electronic resources.

The bottom line is quite simple search directory. Creates a systematic
and rubritsirovannaya collection of links to online resources with a brief
description of each is included in the resource directory. Catalogues can be
divided into general and specialized, with catalogs often differ significantly in
resources coverage included in their composition, it can be divided into
regional, national and global catalogs.

Making directory can be either semi-automatically or manually.
Naturally, the manual work on the classification and annotation resources is
valued more. At the same time, it is necessary to take into account that the
manual work requires time and effort, so resources coverage Rounds catalogs
smaller than can find search engines. But at the same time often the quality of
the resources described in catalogs, is higher as search engine spam is
eliminated, and preference is given to authoritative resources. To select a



suitable directory of your search task is important to know who and how it works to
fill a specific search directory.

Search the directory can be compared with a table of contents of the World
Wide Web. The site is divided into sections, each site has a brief description, but the
content itself, of course, remains on the sites themselves, and not transferred to the
directory.

Directories are very different in their characteristics. Choosing the right web
directory is necessary to pay attention to the following features:

» coverage of the resources that are included in the database (you can find two
or three well-known to you the popular site, and try to find one or two of the little-
known);

« the quality or rather the selection stringency sites introduced into the
directory (is essential level of professionalism of the editors and the degree of
commercialization of inclusion in the site directory);

« accuracy of annotations (annotations are important sites by the creators or
editors specially written)

* The replenishment rate, which is very essential at the present rate (some
editors catalogs declare daily or weekly replenishment base directory).

Why catalogs if there is search engines? - you ask. The answer to this question
was already obvious. Search engines are looking for electronic documents, search the
catalogs looking for, above all, sites, with, you can find thematically related sites.
Thus, a particularly convenient to use if you are not interested in an answer to a
specific question, and a selection of websites on a particular topic. Sometimes, for
example, in the case of the "hidden web", directories are the only way to search for
resources that do not fall in the index search.

To use the web directory is not necessary to reinvent the search query.
According to the catalog, you can navigate through the links heading categories,
reflecting the category tree. Inside each category of sites can usually be sorted
alphabetically, by creation time, attendance or credibility (each directory editors
opinion that is the most essential feature).

People sometimes do not distinguish between directories on search engines and
directories as you can usually look at the request of the keywords. But it is important
to understand that when accessing the web directory search is performed only on the
names and descriptions of resources included in the data directory.

Catalog Yandex

Catalog Yandex is a leading Russian-language directory. Turning resource
directory occurs as free, and in commercial terms. Catalog Yandex is built on the
principle of categorization of the facet, the essence of which is that every resource is
not one group gets (based on themes), and once in a few, with additional features
designed to clarify and limit the electronic resources based on the needs of the user.
Thus, in addition to the catalog Yandex theme sites classified by the region and the
nature of the information provided.
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Pic. Yandex catalog

Yandex catalog provides basic navigation capabilities in the catalog:
search sites and heading on request, run on sections of the catalog, each level is
different titles scale as well as select additional sites faceted characteristics:
region and type of information.

Open Directory Project (ODP).

ODP - the leading international volunteer project to create an all-
inclusive search engine directory. The essential difference is the ODP directory
editorial board: thousands of professionals, volunteers from different countries
are registered as ODP editors. The main objective of the editors - to distinguish
quality from poor resource and give a true and appropriate brief description of
reality sites in its area of interest. Anyone can recommend the site into one of
the categories of directory-headings ODP, but before the publication of such a
request shall check and approve the column editor. Also, anyone can become a
co-editor of one of the headings of the directory, it is necessary to submit a
special application and recommend three sites on the desired category, is not
described in the catalog. After checking an experienced editor, you can get to
work. This collective work to protect a catalog of search engine spam, which is
designed to fool the search engines and users, as well as to improve the quality
annotations, which are sites.
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Pic. The Russian-language version of the Open Directory Project

List.ru

Catalog List.ru one of the most famous in RuNet. With it you can perform full-
text search for resources by their names, descriptions and keywords. To search the
Internet using the Google database. Issuance of search results is carried out according
to the categories: Server name, a brief description. The ability to sort servers in each
category, alphabetically, by adding time on transitions.
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Pic. Mail.ru catalog

1.2. rating system

Rating System - a variation of the search directory, which provides for
the organization issuing the number of visitors hits. That is, the main criterion
Is the popularity of the resource, which, alas, is not always indicative of its
usefulness, content and informative value. Therefore, rating systems are best
suited for search of entertainment and news content. An example of a rating
system is a well-known portal alexa.com assess the popularity of Internet
resources.

1.3. search indexes

Search indexes - a computerized system. They are able to operate
without human intervention, and because of their knowledge of the true
network resources much more. ProindeksirovannyhWeb number of pages can
be measured in hundreds of millions. Job search pointer occurs in three phases,
of which the first two are preparatory and invisible to the user. Please search
pointer collects all the information from WorldWideWebi uses for this purpose
a special program similar browsers. The specified page is copied to the search
index server, and then there are all the hyperlinks that are on it, on those in
their URL-addresses, and copied resources found there, and so on. D,

After copying razyskannyhWeb resources to the search engine server
begins the second phase of work - indexing. The indexed database - a kind of
dictionary. It is necessary to ensure that the search engine can quickly respond
to user requests. Modern systems give answers in a fraction of a second.

At the third stage, the client request processing and issuance of search
results to him in the form of hyperlinks list. These links can be used to navigate
to interesting resources. For example, simply enter a word in the search field



football and Russian search engine will give thousands of links, grouping them by 10
- 20 pieces on the displayed page. The user needs to go in the first ten links, expired
at the moment, it is very annoying, if there are links straight to the neighboring files
of the same server. The worst option, when a row are a few links that lead to a single
resource, but located on different servers.

All the search engines get their initial information from the same Web-space,
so the original database they can be relatively similar, but the third stage, the issuance
of the search results appear her best personality traits. The sort operation of the
results is called ranking. Each found the Web-page, the system assigns a certain
rating, which should reflect the quality of the material. High ratings obtained pages
that keyword used in the query is included in the header. rating level rises, if the word
is found on the Web-page a few times, but not too often. Favorably influences the
rating of occurrences of the word in the first 5 - 6 paragraphs of text - they are
considered the most important for indexing.

Very well, if the keywords used in the query, enter the alternative text
accompanying the pictures. For search engine this is a sure sign that this page exactly
matches the request. Another indication of the quality of Web-pages is the fact that it
has a link to any other Web-pages. So, this Web-site is popular and has a high rate of
citation.

The need for ranking search results is evident. Without it, customers would be
drowned in a stream links offered. However, there is a negative side: each search
engine has its own ranking of the policy and it is possible that the views of the
founders of the search engine is not quite the same as the client's views.

Before you start looking, you need to clearly articulate the purpose of the
search, and also try to pick up all sorts of word forms and other variants of the
wording of the request. This may, in some cases significantly speed up the search, but
also give a lot more options, of which it is already possible to choose the most
suitable. In addition, if you know in advance what kind of company, company or
organization belongs to the resource of interest, you can try to go to the official page
of the company. Typically, large companies address in tune with their names, for
example www.pepsi.com, www.gaz.ru, www.motorola.ru.

2. Four types of search

All search pointers implement multiple search algorithms.

Simple Search. With a simple search query in the box to type one or more
words that describe the content of the document. Receptions simple search in
different search their systems.

Advanced Search - always involves a request from a group of words that are
associated with logical operators. The main advantage of the expanded search that
entry rules keywords and Boolean operators in different systems either identical or
very similar.


http://www.motorola.ru/

Contextual search - useful kind of research that is not implemented in all
search indexes. Contextual search to match exact phrases or groups of words in
search engines, including this method, the key phrase is in quotation marks.

Special search. With this kind of search teams sought additional
information in the different search engines, these commands on your own.

3. Search techniques in the «Google» system

Google -one of the fastest search engines. Today, the word most people
Googledlya represents the largest web search engine. By the way, one of the
two creators of the server became our compatriot Sergey Brin.

Google's interface can be customized in different ways. Google is able to
"talk" to the seventies. Interestingly, there was a place on the list for most of
the languages of the former Soviet Union, including, of course, the Ukrainian
and Russian! To convert your Google interface once is enough to select the
desired item in the menu Language settings - to further their own page will be
loaded into the "right" mode. By the way, with the Russian language Google
copes fine, not enough unless the favorite yandeksovskogo Quest with word
forms. That is, typing a Google query "big elephant", you will find only those
pages on which both words are in the nominative case. "Elephant, Elephant,
Elephant on" and other forms will not be found. However, due to the fact that
Google is not just for .mobi area, both domestic search engines, and with all
the information space web, thanks to it you can find a lot of new resources.

Google is working much faster than their peers, and most importantly,
the results have a high degree of relevance (relevance of search results to the
real state of affairs on the web). Unlike other search engines, in the "top ten" of
the results issued by Google, you will not find any information garbage and
random sites: place the site in the list is directly linked to the number of links to
it from other servers of similar subjects.

An interesting feature of Google is the presence of a second button next
to the search box. If the first button launches the traditional mechanism, the
second button once will transfer the user to the site, which, according to
Google, it best fits the needs.

Finally, the third and the main trump Google has become well-thought-
out set of search services. On Google today offers visitors the following:

Traditional search on the Internet sites and pages included in the
database in an automatic mode with the help of "spider." In addition to the
simple search and advanced yet available - in this mode you can, in particular,
make a selection of documents in a particular language, specify how many
results will be displayed on the page. Finally, you can search within a single
site or page.

When working with the standard search box, you can use search
operators:



+ (AND) - to search for pages that contain all the words: beatles + lennon

- (NONE) - to search for pages that contain the first of these words, but not
containing the second: gates - bill

OR- to find pages that contain either one or the second one separated by the
operator of words and combinations: oshoORrajneesh

""" - To find pages with these unbreakable phrases: «rollingstones»

Search the catalog. Not long ago, Google has got its own directory, which has
already made a few hundred thousand pages and sites from around the world.
"Locale" system applies here: in addition to the main catalog, Google puts you even
"local".

Search newsgroups. Becoming the owner of the famous archive DejaNews
mailings, Google was able to please its visitors the opportunity to find information in
the newsgroups. Today, thanks to Google, you can find any message sent to one of
the hundreds of thousands of newsgroups in the past five to seven years.

Image Search. Found images can be, among other things, sorted by size,
display only a list of the required image format.

Finally mention another important trump Google- opportunity to work with all
of the server services without calling on his page. Especially for those who have to
send to Google a dozen times a day, server makers have come up with a special
search bar GoogleToolbar, which is built into your browser and constantly looming in
front of your eyes.

You get like a second address field in which you can type the text of the
request. Next to the panel provides a quick search buttons across the web, and on the
current site. Finally, the panel has a special indicator that allows to evaluate the
popularity of a site or a page on which you are at this moment.

To install the Google Toolbar, you must go to his personal website at
http://toolbar.google.com. and then just follow the detailed installation instructions.

Words, Google development is in full swing and, if the pace will continue, "the
search engine number one" to secure for Russia this server, at least, the Google has
long been recognized as a favorite. By the way, and you can use Google to search for
Russian-language pages located outside Russia - so you can find documents, which
can not cope even Yandex.

4. Search techniques in «Yandex» system

Yandex - a search engine that can be found on your request in the Russian part
of the Internet the most suitable Web-pages, news, images, encyclopaedia articles or
goods, to answer the question about the weather or cultural events.

Search Single slovu.V the search field the search term entered and click "Find."
The words are sought, taking into account all possible word forms. If the search word
forms are not required, it can be canceled by putting "!"" Before the word.

Search for a group of words. If words are separated by a space, then the sought
documents that are found in one sentence all the words entered. In order to strictly
ensure the occurrence of words in a sentence, it is necessary to put a sign "+" together



with the word in front of them, to which it relates (+ be + + or not). A little
trick. The same result can be achieved by setting the "binding™ of the word in
guotation marks:. *To be or not to be"

Search citations. If you want to find the exact quote, just ask the search
phrase in quotation marks. This query all pages are found, in which you have
the correct quote.

Searching for a name. Words with large and small letters are
considered different forms of the same words, so do not care what the register
used in the query. The exception is the operator of the exact shape. Upon
request, "Meadows" will find all documents containing this word form in any
case, and "Luzhkov" on request - only documents in which there is a form of
"Luzhkov" with a capital letter. This is useful if the required proper name
coincides with the common phrase, for example, a group of black coffee.

Receptions exclude words from your search. To exclude documents that
meet the definition of a word, precede that word: "-" sign without spaces (strict
exclusion of proposals); the sign "~" (non-strict exclusion of proposals); sign
"~~" (with the exception of the whole document) .For example, if you need a
description of Paris, not many travel agencies offer, ask inquiry guide to Paris -
agentstvo -tur.

Searching results. In Yandex search results page has a text explaining the
search results and links, making it possible to sort the found or refine the query.

Search within results. If the request Yandex has found a lot of
documents, but on a broader topic than you would like, you can shorten this
list, specifying the request. Another option - to include in the box results in the
search form to specify additional keywords, and the next search will be carried
out only on the documents that were selected in the previous search. For
example, to find pages about the air conditioning - funds intended for hair care
(instead of HVAC equipment), you can request air conditioning, to determine
the search area. And then, checking the results, - the word "hair".

Parallel searches. Yandex is able to search not only websites, but also
news, products, images, etc. When you specify a query, the search is conducted
simultaneously in all "parallel” database, and if something is found, Yandex
will display the information in search results. In the right column - products
and pictures at the bottom or top of the page - news, dictionaries, maps, poster,
weather. And all this - one request! At the top of the list of found documents
Issued statistics query words and documents found.

Related documents. Link "Related Documents™ allows you to find pages
that are similar to your choice and can respond to the request as well. If the
page-tag has already been removed from the site, Yandex will display a
message: "The requested (e) the document (s) could not be found (s)." By
default, the link is not displayed, you can turn it on display in the search



settings. You can also search for similar documents in the form of an advanced
search.

Another site. Link "Even from the site" allows you to see all the documents
from the site that match the query. You can also set restrictions on a site in the form
of an advanced search.

Sort the results. You can sort the results page in one of two ways:

* The degree of compliance with the request (relevance);

* The last-modified date of the document.

Default sorting is by relevance, by date and sorting is needed, as a rule, only
when you are looking for the most recent documents.

Other search engines. If Yandex response to your inquiry proved insufficiently
precise, try to formulate the request otherwise, or set it to other search engines. Just
click on the link with the name of the search engine, and a new window will open its
search results.

5. Search techniques in «Yahoo» system

Yahoo offers a new and faster ways to find specific information on the Internet
or in Yahoo. Now you have access to a whole arsenal of tools in one simple search
session.

Several ways to be found quickly. On the results page you will see Yahoo
Search links to other types of search results on the right.

* News: Yahoo Search among the last events and messages.

* Pictures: Pictures, illustrations, and icons from around the web.

Doing search "Internet" section, you can leave the same terms in the search
box. Click on one of the links or pictures News, and you'll see a new page results
related to your search, but already contains resources from other sections.

For example, after searching the Internet sites about cars, you can click on the
link Pictures to find the photograph of automobiles. Then click on the news to see the
latest news reports on cars.

You can initiate a search for any of these species, as well as others from the
home page Russian Yahoo Search at ru.search.yahoo.com.

Results. The results page on the Internet is divided into several parts, so you
can easily find what you need.

Pages that most successfully meeting the search criteria are placed in the top of
the results page.

The results of the Internet - it links to relevant sites that have been found by
means of search technology Yahoo, sometimes combined with the results from our
catalog and other resources search Yahoo

Advanced Search. Advanced search on the Internet will help you find sites that
match a specific criteria, including such as various variants of the words entry and the
date of the last update pages. Selectable search advanced search options apply only to
the current search. Search the Web, in the news and image search each have their



advanced search page that offers you a unique set of capabilities to refine the
search session.
3. The purpose of activity of students in class:
The student should know:
1. What is the Internet.
2. What is a Browser.
3. The major search engines.
The student should be able to:
6. Work with your computer.
7. Work in the browser.
8. Finding the necessary information.

4. Learning content:
1. The main types of search engines.
1.1. Search directories.
1.2. Rating system.
1.3. Search indexes.
2. Four types of search.
3. search techniques in the «Google» system.
4. Search techniques in «Yandex» system.
5. Search techniques in «Yahoo» system.

5. The list of questions to test the level of knowledge:
. What is the search index?
. Why do you need the ability to search for information on the Internet?
. What is the difference between search engines?
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6. The list of questions to check the final level of knowledge:
. Describe the information retrieval process.
. Describe the main types of search.
. Describe the search «Google» system.
. Describe the «Yandex» search engine.
. «Yahoo» Describe the search engine.
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7. Using a search engine to find information on cardiovascular disease.

8. Independent work of students:
Learn the basic principles of information retrieval on the Internet.

9. Hronokarta training session:
1. Organizing the time - 5 minutes.
2. Monitoring of knowledge - 30 min.



3. Analysis of the theme - 20 min.
4. Practical work - 30 minutes.
5. Wrap-up sessions - 10 min.

10. A list of textbooks for the class:

1. Gelman V.Ya., Shulga OA Buzanov DV Internet in medicine, 2005 MIA g.
2. Medical Internet Resources: A Reference Guide. ... - M .: Dess com 2000.
3. Internet to a doctor. Sinitsyn VE, EA Timonina



Subject 8: ""Tools of the Internet to search for professional information on
individual sections of medical knowledge. Library Information Systems **

1. Scientific and methodological support of the theme:

In the context of the information society is extremely important tool for
sustainable economic and social development is to provide the public
(including remote) access to socially significant information, especially
scientific, educational and cultural nature. It must be admitted that the degree
of accessibility of information resources of Russia with great value and an
equally huge amounts, is still below any criticism. This realization led to the
need to rethink the role, tasks and working methods of traditional storage
centers and information dissemination. There was obvious need for effective
co-operation of all institutions involved in the creation and dissemination of
information and knowledge - research institutions, universities, information
centers, libraries, archives, museums and so on..

So far, the main form of storage and dissemination of information were
the prints, and the main means of access to information was the library. New
information technologies have given new opportunities to meet the challenges
of creating information storage resources, their organization, means and
methods of access to users. In summary, these approaches became known as
the "Digital Libraries" (DL).

2. Brief theory:

1. Digital libraries in the information society. Functions of Digital
Library.

Creating digital libraries and related information infrastructure is
actively underway around the world. It is hard to imagine at the moment All
this has led to the emergence of new, to some extent, a synthetic direction -
electronic library, which brings together experts in the field of information
technology, librarians, information professionals, employees of museums and
archives, publishers and many others.

The main functions of digital libraries are as follows:

1. "Delivery libraries" directly to the user. Delivers library on the user's
desktop.

2. Enhanced capabilities for searching and processing information.
Automated search more effective than a manual.

3. Expansion of access to information opportunities. Placement of digital
content on the network makes them accessible to everyone.

4. Fast updated information. Libraries support the online version of
pointers, encyclopedias, directories, and so forth.

5. Information is available anytime and anywhere. Digital libraries do
not have the start time and completion time of the day.



6. Access to the various types of information. The presentation of information:
text, graphics, sound, animation and others.

The main tasks of the electronic library is the integration of information
resources and efficient navigation in them.

Under the integration of information resources meant their union for the
purpose of use (with a convenient and unified user interface - preferably one) a
variety of information while preserving its properties, features performances and user
manipulation capabilities with it. In particular, digital libraries need to ensure that
work with heterogeneous databases or database systems, providing the user the
efficiency of information searches, regardless of the specific characteristics of
information systems that are accessed.

Efficient navigation in digital libraries understood as the user's ability to find
the necessary information to fully and accurately with the least expenditure of effort
in all the available information space. This approach is well-known information
retrieval used in information systems and databases, are special cases of navigation
aids.

There is an opportunity to restore lost or damaged books. For some users the
electronic form offers the only opportunity to obtain the requested document;

-Provides the ability to produce work with electronic documents, which goes
beyond a simple reading of the text or view the picture (including edit, combine, add,
rearrange electronic documents, create new ones, and so on based on them);

- Use of multimedia publications, providing text, audio and video, allows you
to better absorb the material, that is to receive information in a complex, multiple
senses at the same time... The basic unit of information storage in digital library is an
electronic document.

With the digital library is one more thing - "a collection of electronic
documents™ or "collection of information resources.” The systematic nature of the
collection of information resources is a crucial feature of its distinguishing collection
of other sets of information resources. Adequate systematization of information
resources not only facilitates user access to them, but also enables targeted and
efficient way to explore with them the subject area of the collection.

In general, as was evident from the above definitions, Electronic Library - a
heterogeneous system, that is combining all kinds of data. On the other hand, the
binding properties of the electronic library is structured, systematization of content,
which makes it necessary to share digital library resources into groups by combining
them in electronic documents on any grounds. Such groups are inherently meet the
definition of Information Resources Collection.

Thus, it can be argued that the electronic library, in general, is a hierarchical
system, and may consist of a collection of electronic documents that specify the
logical structure of the library.

In terms of the level of abstraction, information resources digital library are
divided into the data (information) and metadata (meta-information). Resources are



the first species of interest to users of information about the subject area of the
e-library. In turn, the metadata of the electronic library is characterized by the
properties of the electronic library as a whole and its affiliated entities
resources as a real-world use controls and / or user for the correct interpretation
of information resources.

In practice, it has developed a great variety of electronic library systems.
Their functionality vary over a fairly wide range. Along with degenerate cases
(Web-sites available on the Web environment, traditional database systems and
text retrieval system, simple system of electronic library catalogs, etc.) Set up
and operate a system of advanced -electronic libraries, providing a
fundamentally new opportunities for their members.

In order to evaluate the characteristics of scientific (and educational) DL
the following evaluation criteria will be considered:

. application area;

« functionality;

* the nature and content of information resources;

» the methods and technology.

2. Definition of electronic library

At the moment, there are quite a number of definitions of the term
"digital library”, and it can be argued that this concept has already been
formed. But, unfortunately, there is not one that could be considered basic and
comprehensive. Having analyzed the most famous definitions can state the
following:

» Digital Library - is an information system;

» Digital Library - is an information system designed to create, search
and effective access to information;

» Digital Library - is an information system designed for use with remote
or local electronic resources using global data network;

» Digital Library - is an information system that combines the resources
of structuring a single ideology.

Digital Library - Information Service, in which all information resources
contained in machine-readable form, and all the functions of acquisition,
storage, preservation, dispensing and access provided through the use of digital
technologies. F. Guy (National Library of Scotland)

Digital Library - controlled collection of information in conjunction with
the relevant services, the information is stored in digital formats and accessible
on the network. IN AND. Arms

Electronic Library - a collection of electronic resources and associated
technical capabilities for creating, finding and using information.

In this sense they are an extension and expansion of the storage and
retrieval of information, dealing with digital data of any type (text, images,
sounds, static or dynamic images) and existing in distributed networks.



Contents of digital libraries includes data, metadata describing the various
aspects of the data (for example, type of representation, the creator, owner, the right
of reproduction), as well as metadata, consisting of ties or relationships to other
metadata, whether are they internal or external with respect to the electronic library.

Digital library - a collection of electronic resources, organized on the principle
of the library, ie, on the basis of known rules and technologies of traditional
librarianship, including acquisition, processing, classification, subject indexing and
storage and other processes and technologies, including the creation of a directory
and reference and search tools in the electronic form).

Digital Library - is an information system that ensures the safety and effective
use of a diverse collection of electronic documents placed in the system and
accessible via telecommunication networks

Digital library is designed to store various kinds of information, especially text,
and is realized in the form of complex distributed information systems with a unified
interface, as well as the ability to access the Internet. Electronic libraries as a class of
information systems are characterized by:

* Global access to the system in a Web environment;

 metadata support for the system and the users;

« the inclusion of heterogeneous information resources;

» distribution of information resources;

* presence materialized and virtual collections;

* Integration of information resources at various levels;

* use user interface with increased;

* the level of semantics and others.

Digital Library provides new opportunities to work with large volumes of
information. To those include serial, parallel or selective viewing multiple
documents;

multifaceted search throughout the entire volume of information;

copying the necessary documents or fragments thereof, both in paper and other
media;

create your own documents, etc.

3. Scientific Electronic Library

The main objectives of the creation of digital libraries are to provide scientific
research, providing scientists the possibility of effective access to the necessary
information resources, as well as:

* Provide the results of fundamental research broad research community;

» the creation of new technology research, effective tools to carry them out;

 Preventing the loss of valuable scientific collections for future generations
of scientists;

» providing opportunities for scientific cooperation, not only in the regional,
departmental, national, and international scale.



Serious impact on the establishment and on the specifics of the
application of scientific EB has the fact, the scientific community has always
sought to broad cooperation, it realized the need for the exchange of
information, despite the diversity of research subjects, a variety of research
techniques. The democratic character of the scientific community is one of the
main reasons for the successful development of scientific digital libraries and,
as a consequence, to create a scientific digital libraries need to take into
account the multilingual environment of the scientific community, the
heterogeneity of the information used to provide the possibility of operating
data at different levels of abstraction.

At the moment, scientific DL covered almost all areas of knowledge.
On the scale there is a full range of systems:

* EB specific journal or magazine group;

* DL separate research team;

* DL scientific institution, region, department;

* National / International DL.

By category of Information Resources Collection scientific EB can be
both universal and specific areas of expertise or scientific field. Separately,
you can select scientific DLs that are based on the personal archives of
prominent scientists.

But in almost all cases, the basis of scientific information resources of
digital libraries are scientific publications in various forms (articles, reports,
monographs, dissertations, abstracts ...). In addition, research DL can also
contain:

* bibliographic information;

* The results of various experiments, observation, measurement,
simulation of reality;

* models of the processes, phenomena, phenomena, presented in
various forms;

* news, event information (calendar of conferences, etc.)

Like in any other digital libraries, information resources of scientific
DLs are a set of metadata + electronic document, ie scientific EB also
contains:

» metadata describing information resources;

» catalogs of collections and descriptions of their elements, qualifiers
and other means of systematization.

The main feature of the information resources of scientific DL is their
heterogeneity in different aspects - a variety of presentation media (text,
numeric data, static image, video, audio, multimedia ...).

Another feature of the information resources of scientific EB is the
possibility of representing the subject area that are sufficient to carry out



research directly, that is, the use of scientific digital libraries, not only for the
information support, but also as a research site.

Another specific feature of information resources of scientific DLs having
essential and defining specific requirements for the functional characteristics of EB,
Is the factor of aging information resources as a result of various experiments, as well
as the information contained in the articles, monographs and other publications.

All the above mentioned properties and characteristics of information
resources, collection and proper scientific EB determine the fact that EB can be
created in a variety of versions and architecture - from concentrated to distributed
from materialized to virtual, and technology - some Web-sites, database systems data,
text, a system based on the integration technologies.

The main functions of research EB are:

1. Keeping and updating collections of information resources.

2. Provision of user access to collections.

3. Formation of collections (digitization, recording experiments and
observations directly in the process of carrying out, etc.).

4. Integration of publishing technologies and technologies of formation of
collections.

5. Providing various embedded applications or overbuilt servisov- transforming
DLs in the research polygon (Virtual Observatory, a virtual chemical or biological
laboratory, etc.).

Features scientific EB is manifested not in the set of functions, and the
specifics of their implementation, taking into account the properties of scientific
information resources and collections.

4. Educational Electronic Libraries

Among the thematic digital library is not the last place is occupied by
educational digital libraries. The main objectives are the creation of educational
digital libraries providing of training, the provision of training opportunities effective
access to the necessary educational information resources, as well as:

 improving the educational process, the organization of independent work of
students, the organization of work and vneaudornyh t. Etc .;

» the creation of new educational techniques, effective tools for their use;

« providing the possibility of using the experience and results of educational
and methodical work of the largest educational institutions;

» Saving for the future generations of the original lecture and methodical
material best teachers and scientists of leading universities;

* Providing opportunities for cooperation not only in the regional,
departmental, national, and international scale.

Thus, the fundamental difference between educational EB is the subject area -
the educational process, and common goals - to provide access to and preservation of
information - no different from the others.

following the application of educational digital libraries can be distinguished:



» use the usual way - educational EB EB performs traditional function of
preserving and providing access to information;

» the only difference from other educational digital libraries, in this case,
will be the subject area EB, causes the content specifics - electronic
educational resources (ESM);

» Use for the organization of the educational process - in distance
education, during the classroom, for the organization of independent work of
students.

Like in any other digital libraries, information resources of educational
digital libraries are a set of metadata + electronic document. Metadata
describing the ESM should consider the features of the domain DL, t. E.
Include elements specific to the description of educational resources.

Any ESM educational EB can be "tied" to a particular course of study
(disciplines) that should be reflected in the metadata. The course can also be
cataloged and provided with a detailed description.

Each ESM can determine their level of access:.. Free access without
registration, free access to mandatory registration, paid access to the different
form of payment, etc. In fact the electronic document - ESM - no restrictions, it
can be of any type - text audio or video, software package, and so on. d.

Functions educational EB essentially depend on the application. If it is
used in the traditional way, then its basic functionality identical to that of other
types of EB. This is the formation and storage of collections of information
resources, providing user access, metadata support, support for different user
information, and so on. E., T. E. Those features that were considered in the
previous sections.

New educational DL associated with it in the educational process. First
and foremost, it is to ensure the ability to work with complex, specific to the
educational EB electronic documents; provision of teachers to prepare and
conduct classes; Integration with other educational information systems.

Providing this functionality is achieved by expanding the set of elements
of metadata and search capabilities of EB. In profile, the metadata elements to
be included for the analysis of painting a large volume of documents and
complex structure, ie. E. Cataloging chapters, sections and other parts of the
document. Thus, when using a conventional attribute search, you can get a
specific section of the document corresponding to the search query, as opposed
to the traditional approach, when, after receiving the necessary document had
to or view it in its entirety or to organize an additional search within the
document to get the desired information.

Enhanced search capabilities DL in this case involves the organization of
full-text search and navigation within the ESM.

ELS "consultant physician» (http://www.rosmedlib.ru)



"Physician consultant™ - is an electronic medical information and educational
system, or library resources which are available on the Internet. The materials in the
"medical consultant”, developed by leading Russian experts on the basis of current
scientific knowledge (evidence-based medicine). The information has been prepared
in keeping with the scientific-practical medical society (global, European and
Russian) in the relevant specialty. All materials have passed the mandatory
independent review. The system includes medical news, textbooks, monographs,
national guidelines, and much more; designed both for students and for teachers and
health practitioners.

To log in, you must register on the site. Access to the system is only possible
with the operating computers connected to the local network of the university.

ELS ‘student adviser. Electronic library of the medical school
»(http://www.studmedlib.ru)

ELS 'student adviser. Electronic library of the medical school "- the university
offers the most comprehensive sets of required literature in accordance with the
curriculum and the requirements of state standards. The total number of publications -
2060; textbooks and posobiy- 622; It shows three publishers: "GEOTAR-Media",
"Medicine", "SpetsLit"; videos on the practical skills and medical manipulations;
atlases, workshops, handbooks, collections of assignments, practical guides;
magazines, primarily included in the WAC list - more than 30 titles. Users can copy
text, create your own notes and bookmarks.

ELS 'student consultant medical college »(www.medcollegelib.ru)

ELS 'student medical college consultant - e-library College of Medicine - an
innovative tool for teachers and students of secondary vocational education. Total
number of publications - over 469, spanning at least 85% of the subjects studied in
medical colleges; textbooks and manuals with vultures - not less than 75% of the total
amount included in the DEC; It shows three publishers: "GEOTAR-Media",
"Medicine", "SpetsLit"; videos on the practical skills and medical manipulations;
atlases, workshops, handbooks, collections of assignments, practical guides;
magazines, primarily included in the WAC list - more than 30 titles.

Users can copy text, create your own notes and bookmarks.

Electronic Library System "Lan™ publishing house (e.lanbook.com)

Electronic Library publishing system "Lan" - a resource that includes both
electronic versions of books of publishing house "Lan" and other leading publishers
of textbooks, as well as electronic versions of periodicals on natural, technical and
humanities. The purpose of the resource - providing access to higher education
institutions for scientific, educational literature and scientific periodicals on the
maximum number of core areas, so the range of electronic-library system is
constantly expanding.

The ELSs are books on the following topics: medicine (318 ind.), Chemistry
(535 ind.), Psychology and Pedagogy (1213 ind.). It provided a permanent open
access to all the free content publishing FBS "Lan".



Federal electronic medical library (FEML) (femb.ru)

Federal electronic medical library (FEML) is part of the unified state
information system in the health sector as a reference system.

Just FEMB published in the open access document 23993.

Placing Documents in FEMB carried out in accordance with copyright
and related rights of the Russian Federation legislation.

FEML created based on the funds of the Central Scientific Library of
Medicine (TSNML) of the First Moscow State Medical University. Sechenov.

Federal electronic medical library (FEML) should provide fundamental
modernization of information support of medicine and public health, as a result
of which the most important information in digital form will be available in all
educational, scientific and medical institutions through the Internet to meet the
copyright requirements. Access to FEML free, user registration is required.
The system provides the ability to explore the contents of the full texts of
documents in read-only mode.

Central Scientific Library of Medicine (TsNMb) MMA.. Sechenov), the
base of "Russian Medicine™ data - contains information about the primary
sources received by TsNMb since 1988 within the divisions:

» Article - include articles from local magazines and collections;

» dissertation - domestic include abstracts and dissertations;

* Book - include domestic, and foreign books translated.

This database includes only bibliographic descriptions of primary
sources available in TsNMb, and almost does not contain abstracts and text of
the documents themselves. Subscribers can order the paper and electronic
copies of articles and abstracts. TSNMb does not manufacture complete copies
of books and dissertations, as well as electronic copies of the text of primary
sources.

Thesaurus in Medicine MeSH

Thesaurus MeSH developing US National Medical Library for indexing
and retrieval of documents in the life sciences (Medical Subject Headings,
1992). In 2009, a thesaurus contains more than 25 thousand handles.
Descriptors are provided with interpretations and a list of synonyms or similar
within the meaning of the terms (entry terms).

The relationship between the descriptors can be hierarchical - such
relationships are presented in a hierarchical tree - and associative. Location in
the tree is marked by special tags Stock No tree, and each handle can include a
few trees, that is, he mapped several such rooms.

Non-descriptor in the hierarchical tree can be changed with the
development of the thesaurus, each handle has a unique identification number,
which remains the same throughout the lifetime of the handle.



At the top level of the hierarchy of the thesaurus is 16 descriptors: anatomy,
disease organisms, chemicals and drugs, techniques and equipment, psychiatry and
psychopathology ,. Person, geography and others.

The thesaurus is also a standard set of qualifiers (allowable qualifiers), which
can be added to the descriptor to narrow subjects:. BS - blood supply, PP -
physiopathology, the MI - microbiology, etc. These qualifiers are especially
important in a lot of case documents that mention a lot of concepts in different
aspects - then through the qualifiers, you can more accurately determine what concept
from what point of view is considered.

The purpose of activity of students in class:

The student should know:

1. Basic definitions and terms.

2. The difference between the union catalogs and medical libraries.

3. How can | search for medical resources.

4. The difference between scientific and educational EB EB.

The student should be able to:

. Use union catalogs.

. Use medical libraries.

. Using scientific DL

. Use educational DL.

. Use of medical reference books and directories of drugs.
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4. Learning content:
. Digital libraries in the information society. Functions of Digital Library.
. Definition of electronic library
. Scientific Electronic Library
. Educational Electronic Libraries
. Medical Library Systems

The next challenge is the integration of educational digital libraries with other
information systems, a prerequisite of which is interoperability, ie. E. Providing
opportunities to work together. Ensuring integration is achieved:

« the use of well-known metadata schemes or correct description of their own
profile;

» the use of Semantic Web technologies - XML, RDF, ontologies, and metadata
for the formation of ESM;

* the possibility of access to EB for common protocols, providing information
retrieval, - Z39.50, SRU / SRW, etc .;.

* the use of web services.
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5. Medical Library Systems



5. The list of questions to test the level of knowledge:
. What is a digital library?
. Why do you need the creation of digital libraries?
. What is the difference between the different library systems?
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6. The list of questions to check the final level of knowledge:
. List the basic functions of digital libraries.
. List the main objectives of the electronic library.
. The criteria for evaluation of scientific digital libraries.
. The main objectives of the creation of digital libraries research.
. The main functions of research DL.
. The main purpose of creation of educational digital libraries.
. Functions of educational digital libraries.
. Describe a medical library system.
7. Using the Medical Library Systems, to find relevant information:
a. cardiovascular diseases.
b. of anemia in children: causes, symptoms, treatment.
c. Toxoplasmosis of the disease, as well as information about hereditary
diseases,
d. about the drug Aspirin and print the document.
Keep the information found in MS WORD file.
8. Independent work of students:
Learn the basic principles of information retrieval on the Internet.
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9. Hronokarta training session:
6. Organizing the time - 5 minutes.
7. Monitoring of knowledge - 30 min.
8. Analysis of the theme - 20 min.
9. Practical work - 30 minutes.
10. Wrap-up sessions - 10 min.

10. A list of textbooks for the class:
1. Gelman V.Ya., Shulga OA Buzanov DV Internet in medicine, 2005 MIA g.
2. Medical Internet Resources: A Reference Guide. ... - M .: Dess com 2000.
3. Internet to a doctor. Sinitsyn VE, EA Timonina



Subject 9: ""The algorithm simulation of physiological processes.
Management Information Systems health care setting (AIS LPU) ™

1. Scientific and methodological support of the theme:

Today is a topical issue of new formulations of problems of mathematical
modeling in biomedical practice. For the most part a number of areas related to the
modeling of complex medical and biological systems have not received development.

The theoretical issues of the mathematical modeling of the medical diagnosis
and the use of simulation for solving urgent practical problems as well as problems in
the development of medical information diagnostic support systems dedicated to the
work, primarily on questions of a theoretical nature, stringent productions tasks, the
application of mathematical analysis to develop a means of setting diagnosis.

The problems, the development of tools to support medical and diagnostic
activities include: weak formalization of knowledge and high dimensional feature
space, not allowing a doctor (especially a young specialist) immediately to cover a
full range of diagnostic pathology markers. The peculiarity of the diagnosis in early
childhood is also a weak informativeness of each of the features, taken separately.

Quoted in the literature of preclinical diagnosis algorithms based on regression
models of physiological state based on the idea that the whole range of transitions
from one state to another can be described by a linear function. In fact, the complex
physiological and pathological processes of adaptation to the environment can hardly
have a linear nature. This is due to the fact that at different stages of the adaptation of
the interaction of biomechanical processes, compensation and adaptation mechanisms
actually develops differently. Spaces, which are deployed in various departments of
the compensation processes of the musculoskeletal system, it is extremely
heterogeneous. Therefore, to accurately describe them, use a specific mathematical
techniques, in particular, non-linear regression or polynomial equation of varying
degree. According to the descriptions of the various means of mathematical modeling
used in medical applications, one of the most appropriate methods aimed at solving
problems of medical diagnosis is the discriminant analysis.

Typical medical information system designed to support the work processes of
therapeutic and prophylactic institutions (MPI)

One of the important features that should have an information system is its
ability to automate large and very large health care institutions, which represent the
complex systems with multiple repeating structural units. For such complex health
care facilities as a relevant task to obtain data on the work of each of the structural
components of the institution, which itself can act as an independent institution, and
the problem of obtaining data on the work of the whole complex (the institution as a
whole)

2. Brief theory:

1. Modeling physiological processes.



Algorithm - a set of instructions that describe procedures artist to achieve
the result of solving the problem in a finite time.

Modelirovanie- study of objects of knowledge on their models;
Construction and investigation of models of real objects, processes or
phenomena in order to obtain an explanation of these phenomena, as well as to
predict the phenomena of interest to researchers.

Physiology (from grech.puoic- grech.Adyoc- nature and knowledge) - the
science of the spirit of the living and life in normal and pathological, that is, the
laws governing the functioning and regulation of biological systems of various
organization levels, the extent of the norm of life processes (normal
physiology) and painful deviations from it (pathophysiology).

In medicine, physiology, along with anatomy and histology is a basic
theoretical foundation, through which the doctor brings together disparate facts
and knowledge about the patient in a single whole, assesses his condition, the
level of capacity. And according to the degree of functional disorders, that is,
by the nature and magnitude of abnormalities important physiological
functions - seeks to eliminate these deviations and to return the body to normal,
taking into account the individual, ethnic, gender, age characteristics of the
organism, as well as environmental and social conditions of the environment.

The process from the Latin processus- «for», "move", "promotion"

Simulation (situational simulation) - a method to build models that
describe the processes as they would have passed in reality. Such a model can
"play"” in time for a test, and given their set. In this case the results will be
determined by the random nature of the process. These data can be obtained
fairly stable statistics.

A quantitative description of the observed phenomena has long been the
norm medical research. For the most part, however, it is limited to some
statistical analysis (now more often - a multi-dimensional).

Examples of the construction of dynamic models, such as the spread of
viral infection, is quite rare. In our opinion, this hinders the widespread (but
false) belief that "high-grade™ can only be analytical models that provide a
forecast, but also other (just) an opinion on the excessive complexity of the
procedure for constructing and solving a system of differential equations.

Before forecast, you need to understand, explain. Therefore, firstly, it is
necessary to discard only look at the model as prediction means and see it in
the way of studying the characteristics of biological systems, including those
that are hidden from direct observation. Second, to explain the case you want
to use other effective, the funds available but the majority of researchers,
namely, simulation.

To create simulation models are much lighter than the analysis because
they are computer programs that can be built on the basis of the simplest
(linear) algebraic equations. Moreover, the system of algebraic equations does



not have to decide, as the model parameters are selected with the help of special
computer algorithms (optimization procedures). From this perspective, simulations
look like numerical, arithmetic, model. Simulation models allow to completely "solve
specific problems arithmetical methods".

Example 2. Solutions modeling tasks.

We calculate the number of vipers that bite ecologist for the fifth time.
Methods of labeling require a plurality of catching these animals, which are
sometimes bite. With the acquisition of experience increased and caution, so the
distance between bites (and the time and numbers of individuals) is increasing.
Accumulated statistics provides a glimpse into the future and know in advance with
what the next number will have to be especially careful to apply? To do this, we
construct a simple model according to two indicators and try to make a prediction.

Turn on the computer and start MS Excel program.

First, we introduce the data in the Excel worksheet.
A | B | |

¥iyc Mz N ocobn
1 14
2 99
3 1148
4 174

Pic. Number of individuals viper, giving birth ecologist

The next stage - the mathematical description of the model. If you build a
graph, it is seen that the desired relationship is likely to curved, and can be described,
for example, the exponential function:

Y =a=XP

Applying our notation, we obtain the estimated model:

N=a=*Y?

where

N '- the estimated number of individuals;

Y - bite number in order.

Conditional approximate values of the model parameters (coefficients a and b)
must be set as soon as we introduce them in worksheet cells, C1 =1, C2 = 1.

Now you can create a model in an Excel worksheet - enter the model formula.
spreadsheet program rules require that the model values for each sample object (or
one time step model) are calculated explicitly. We introduce into cells C3: C9 model
formula, from C4:



A | B | C |
1 a= |
2 b= |
3 | ¥uyc M N ocobn
4 1 14
] 2 99
B 3 1128
7 4 1724
g 5

Pic Enter the priﬁﬂary values of the parameters

C4 =$C$1*A4/$C$2, where

$ C $ 1 - the absolute address to the setting of a cell,

$ C $ 2 - the absolute address with the value of the parameter b cells
A4 - relative address with the value of the US value of the cell

* /A - arithmetic operations, multiplication and exponentiation corresponding
design model.

After pressing the Enter key cell will contain the calculated (obviously
inaccurate) numbers viper value at current levels, the parameters a and b.

1

1 l

CIHMC || X o = =3CF1TALGCE2
A B | Cc | D | E

a= 1

b= 1

¥ryc Me N ocofn N
1 14[=3C$1*A4"5CH2
2 o9

ntering the first model of the formula.

[T | | e | —

Pic.

Now we need to calculate the remaining value of the model, using the
"auto-complete” procedure. To do this, select cell C4, direct the mouse cursor
to the bottom right corner of her: he of the white cross turns into a black cross.

A B | Cc |
1 a= |
2 b= 1
3 ¥y M M ocofm N
4 1 14| 1
5 2 00 '

Pic. Start of operation autocomplete cursor



By clicking the left mouse button, drag the cursor to the lower corner of the
cell C7, let go. All the cells were filled with stereotyped formulas that calculate
model values

A B | C |
1 a= 1
2 b= |
3 | ¥y Mz N ocofn N
4 |
5 2
b 3 1123
7 4 1724 i
ju}

Pic. Completion operations autocomplete

By double-clicking the left mouse button (better yet, press the function key
«F2») formula in any cell becomes editable. Thus it is possible to verify that in each
of the cells contains a formula having the correct relative and absolute links to the
cell with the values (a and b) and the leading variable (Y).

A | B c | o |

1 a= 1

2 = 1

3 | ¥eyc Me Nocobn N'

4 1 14 1

5 2 0g 2

b 3 1128[=8CEI*ASCS2
7 4 174 )

Pic. The contents of cells - a model of the formula

The formula calculates the value of each cell numbers biting individuals for
"their" bite rooms (from column A).

Thus, the model value (N ') are counted, but they are obviously bad consistent
with real values (N). For example, a secondary bite made the 99th caught a viper, and
the model has given N '= 2. It is clear that the values of the parameters we have taken
ill characterize the relationship between the studied traits. It is necessary to somehow
improve them. To do this, we calculate the first difference cumulative model of
reality. This role can perform the squared difference between each pair of values of
the model - the reality:

¢ = (Mog.—Pean.)* = (N/ — N,)=.

On an Excel worksheet, this formula will look like this, for example, for line 4:

D4 =(C4— B4)A2 = (1-14)* =-13° = 169.



Using the procedure of "autofill”, it is easy to calculate the same values for all pairs
of variables N and N '(for verification is to click in the D5 and press «F2»).

We denote the resulting graph, for example, through "f". In cell D8, type the formula
calculation of the sum of the squares of the differences between the real and the

model variables:

nnn D8=CYMM(D4:D7) = 4233603.

A | B | ¢ | D | E
1 a= 1
2 h= 1
3 | ¥ryc M: N ocobr N i
4 1 14 1 164
5 2] o9 3/=(C5-B5Y
B 3 1128 3 1265625

4233603 Value calculated in cell D8, characterizes the difference
between the calculated generalized model characteristic values from the source
data. Such a large quantity is determined, apparently, by the fact that randomly
assigned to the coefficients for the model equations poorly match the specifics

of real relationships.

D | =| =Cy¥MM{D4: D7)
A | B | ¢ | D | E

1 a= 1

2 h= 1

3 |¥eyc Mz N ocobn N 1]

4 1 14 1 169

5 2 90 2 5409

5 3 1128 3 1265625

7 4 1724 4 2053400

8 th= |42336E|3_|

Pic. Calcula‘?ion of the generalized difference functions (F)

We can assume that for certain values of the coefficients of the model is more
accurate to describe the reality and function of differences (value in cell D8) will
decrease. This argument allows you to start searching for the best values of the model
parameters by changing them and tracking function decline differences F.

For example, it would be possible to repeatedly enter the cells C1 and C2
are different settings that reduce F. For example, when a = 100 level difference
function becomes slightly lower than the previous (2,456,157 vs. 4,233,603).



A | B | ¢ | D |
1 a= 10a
2 b= 1
3 |¥xyc Mz Nocobn N 1]
4 1 14 100 73094
5 2 99 2000 10201
a 3 1128 3000 485554
7 4 1724 400 1752976
i 3 500
9 = 2458157
1n

Pic. Manual adjustment of parameter values

Fortunately, the manual adjustment is not necessary because there has built-in
program (macro) in an environment of Excel, search for the best procedure
parameters optimization process. We call it "Solver" command "Tools" from the
menu.

A |8 | ¢ | p | E | F | & | H
1 a= : I
2| b= 1l
| 3 |¥eyc Me N ocofn N 1]
EN 1 14 1 169
1 5 | 2 99 2 8409
| B | 3 1125 3 1265625
| 7| 4 1724 4 2955400
| 8 | P= 4233603
=
T YCTAHOEMTE LENEEVH AHEMAKY! |$D$8 =|'6] Blr]
| 12| | PasHoi: 1 makcHmansHomy SHAUeHMED % sHAUeHHHD: IU =
13
7N € MMHHMANBHOMY SHAHEHHH
5 SMEHARA AHERKK:
E ’—T$C$1=$C$2 %] npeanonosste |

Pic. Setting Macro window "Solver"

If you can not find in the menu command Service search solutions, it is likely
that this procedure is simply not connected, or is not installed. To connect the macro
Search solutions need to call the Add-ins window on the Tools menu, where the tick
title search solutions. After that, the corresponding command will appear on the
Tools menu. If a title search solutions in the Add-ons window, there is no need to use
the installation disc, MSOffice, select Add / Remove / Microsoft Excel / Add-ins, tick
the box and search for a solution after the installation procedure connect.

Macro window that appears on the team search for a solution, you need to fill
in properly (for example, using the mouse):

o Set target cell: $D $ 8

o equal importance: 0

e By changing cell: $ C $ 1: $ C $ 2 (containing the parameter values).



After clicking the button a window will appear summary reports Run,
warning that the search can not find a solution. This is natural, because the task
of the module was to reduce the difference to zero function, and a macro could
only reduce it to the level of P =117 686 (D8 cell).

With "point of view" macro (. See macro settings ...) solution found
unsatisfactory, ie the values obtained are inaccurate coefficients. But from the
point of view of ecology, such a decision may be quite acceptable: the values
in the columns NiN 'have become quite close, well, the statistical significance
of differences can (and should) be studied by statistical methods. Therefore,
there is every reason to maintain the solution found and view the resulting
equation:

This is the desired model. It is, of course, is very primitive and very well
could be calculated in another way - by means of a regression analysis of the
data analysis unit menu service.

Nevertheless, the result is of fundamental importance for the
understanding of the modeling being. Now the user that performed the
proposed example, has mastered the process of constructing the simulation
model.

A | B | ¢ | b | E
a= f3.2425
b= 241289
¥ryc Me N ocofn N 1]
1 14| A3.2425 2424 82

2 98] 336.792 545451
3 1128 895883 538754
4 1724 1793.56) 4835.07

th= 117686
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Pic. Window macro execution "Solver"
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Considered modeling method has the same features as regression
analysis, when it comes to the simple relationship of variables, however, it
becomes indispensable when medic have to study dynamic processes.

In addition, the flexible means of the Excel spreadsheet contain the
possibility to finish building a simulation system and create a framework for
assessing the statistical characteristics of parameters Introductory thesis of the



book is formulated as follows: Excel environment allows you to create models of any
processes and to assess the values of their parameters. The subsequent exposition
devoted to his illustrations.

As for the forecast, then give yourself determine the number of fatal snake,
prompting the search direction. We need to add a line 8, enter the A8 =5 and ...

3. Appointment of the structure and the main characteristics of the 1A

Typical medical information system designed to support the work of MPI
processes.

Medical information system allows you to keep complete records provided to
the patient medical services, automatically generates the necessary medical
documentation (primary examination, diaries, minutes of additional studies,
statements, standard forms dlyamed. Institutions), a detailed report on the work of the
hospital and staff on established statistical and random forms .

4.1. Core modules inherent in the majority of the 11A:

1. electronic medical records. Depending on the profile of the medical
institution (clinic or hospital), ambulatory card or medical history of the patient in an
electronic form can be used. Export EHR to an external format.

2. Statistics. Automation of medical statistics and other forms of reporting.
Online access to the reports of different types: administrative, financial, medical
statistics, financial accounting. The ability to create reports of any complexity.

3. Schedule. Support schedule reception physicians, diagnostic rooms, places
of group classes.

4. Laboratory. Laboratory unit for the organization of the business process and
laboratory work areas. Supports laboratory profiles with the ability to input or
automatic import of research results from the analyzers. Fence biomaterial. Quality
control.

5. Accounting services. Accounting for medical services and settlements with
various counterparties of medical institutions - insurance companies, businesses and
patients.

6. Cashier. Integration with fiscal registrar to implement the cashier's
workplace. The integration with the accounting system, the ability to export
documents and postings in the accounting of the enterprise program.

7. Pharmacy. Support warehouses of medicines and supplies. It is personalized
expense account in the provision of medical services.

8. bed capacity. For hospitals and hospitals in the IlA provides planning and
accounting module ward and hospital beds. Various schemes of reservation
chambers.

9. Plans for treatment. The treatment plan - treatment standards support
mechanism in unity and interaction with other modules of the 1A and convenient tool
that facilitates the work of a doctor.



10. Standards of treatment. The use of state standards of treatment with a
common mechanism of work with treatment plans and templates directory.

11. Replication of the IIA makes it possible to exchange electronic
health records between different institutions, synchronize directories and the
consolidation of financial information.

12. Image processing. Preparation and storage of medical images in
modern conditions allow, as a rule, specialized equipment and systems
software. The IIA may provide for mechanisms for the organization of a
structured image storage, retrieval, viewing and editing images.

13. The interface module. Provides connection of medical equipment and
the organization of import data from external sources using the original
information-sharing technologies.

14. HL7 standard. Using HL7 international standard MIS provides
additional integration with medical devices and external applications.

15. System kernel. Security and confidentiality of data is one of the key
requirements of a modern MIS. It provides access to the database and
implementing the security data. It includes statistics module.

4.2. MIS functions.
MIS should provide the following functions:
* Reception and admission schedule
 Accounting for services rendered
* Electronic medical history / electronic medical record
* Calculations with patients, insurance companies and contractors
* Medical and economic standards
* Statistics and Analysis
 Automation of hospital
» Network management subsidiaries
* Maintain a database of patients, doctors and nursing staff
* (The account of the work of first aid and home care services)

In its operation the system performs the following tasks:

» Search and patient registration.

* Make an appointment.

* Keeping electronic medical records.

* Enter the results of laboratory and special studies.

* Formation and printing medical documents.

 Limit access to the operator's application.

* Logging into account the work of operators at each workstation (AWS).
* Registration of changes in the database and maintaining fiscal database.
» Maintain pharmacy accounting (for the hospital).

* Keeping food accounting (for the hospital).



Work carried out in the I1A in multiplayer mode with differentiation of access rights.
Access control is provided by the identification of the subjects.
When you log on and extradition requests to access user authentication is performed
I[1A. MIS has the necessary data for identification, authentication, and prevents
unauthorized access to resources.
3.The purpose of activity of students in class:
The student should know:
1. Basic concepts and definitions of the simulation of physiological processes.
2. The principle of the dynamic model.
3. Appointment of AIS hospitals.
4. The core modules of information management systems health care setting.
5. What features should provide AIS hospitals.
6. What problems solves the AlS hospitals.

The student should be able to:

. Predict the proposed situation.

. To create a simulation model.

. Work with health facilities "hospital™ system.

. Start and register the AIS LPU "Hospital".

. Keep records of hospital admissions in hospitals "The hospital."”
. Maintain a record and searching for patient information.

. Work with hospital sheets.

. Generate reports in the system.
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4. Learning content:
1. Modeling physiological processes.
1.2. Example Solutions modeling tasks.
2. Purpose, structure and main characteristics of the 11A.
2.1. Core modules inherent in the majority of the 11A.
2.2. MIS functions.

3. Example of information medical institution management system
"HOSPITAL".
3.1. Launch the AIS "The hospital."”
3.2. Register at AIS "HOSPITAL" system.
3.3. Using the toolbar.
3.4. Setting the AIS "The hospital."”
3.5. Editing directories.
4. Consideration of hospitalizations.

4.1. Register a new patient.
4.2. Enter data to search for information in the database and the BDSG.
5. Viewing / Editing information on cases of hospitalization.
5.1. General principles.



5.2. Removal value.

5.3. Selecting information on the cases of hospitalization.

5.4. The list of patients.

6. Information about the patient (in person).

6.1. Tabs "diagnosis”, "Advanced".

6.2. Tabs "Sick leave", "History", "Window Card" tab "History".

7. Formation of a standard medical report forms of statistical reporting.

5. The list of questions to test the level of knowledge:
. What is an algorithm?
. What is a simulation?
. Formulate what physiological process
. What is a simulation model?
. The types of medical information system which is designed to
. List the main modules inherent in standard AIS LPU
. What features should provide a medical information system?
. What problems are solved AIS LPU?
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6. The list of questions to check the final level of knowledge:
. Briefly describe the process of process modeling using MS Exel.
. How does the check-in AIS "Hospital" title.
. How is the new patient registration in the AIS "The hospital."
4. How do | access to the window view / edit the information on cases of
hospitalization.
5. What is the purpose mode "Patient Information."
7. Assignment 1. With the help of a computer model the clinical process
according to an example.

30-year-old woman, brought to the clinic with complaints of SMP
sweating, tremors and drowsiness, mood swings, tearfulness, general
weakness, pain migratory nature throughout the body. In patients with diabetes
mellitus type 1 (DM1), identified 15 years ago, with heavy currents are
constantly changing therapy due to recurrent hyper- and hypoglycemia. On
admission, blood glucose level was 1.2 mmol / I. According to the patient,
within a week it had noted the low level of glucose in the blood, although
insulin is not administered at this time.

The patient revealed diabetic macro- and microangiopathy (neuropathy,
retinopathy). Concomitant diseases: Hashimoto's thyroiditis (hypothyroidism in
phase) on replacement therapy with L-thyroxine; and osteoporosis, about what
it takes calcium and vitamin D. A family history of diabetes, coronary heart

wnN -



disease, the older sister - severe CHD with repeated surgical interventions (died at the
age of 23).

The patient first received in-patient treatment and examination of 5 years ago,
and during this period has always been a cause of hospitalization poor control of
diabetes. 2 years ago after a severe transient hypoglycemia in the hospital were made
all hormonal tests (without disease), insulin dose was reduced, and the patient was
transferred to insulin analogs. Despite changes therapy, diabetes remains poorly
controlled - from severe hypoglycemia to hyperglycemia for more than 30 mmol / |I.

mmol / I.

On examination on admission: general state of moderate severity, mood
suppressed. The reduction of subcutaneous fat, lipodystrophy zones under the
hyperpigmented skin. The body mass index of 16.7 kg / m2 (height 166 cm, weight
46 kg). Rhythmic heartbeat with a heart rate of 110 beats / min, the noise does not
listen. BP 90/60 mm Hg. Pulse on peripheral arteries weak filling. In the lungs
vesicular breathing, no wheezing. Respiratory rate 17 per minute. Abdomen soft,
painless. Urine output is adequate.

During his stay in the hospital, there were episodes of hypoglycemia with
blood glucose levels of 1-2 mmol / L with a loss of consciousness, which required
almost continuous glucose infusion (insulin is not administered), during these attacks
are analyzed levels of C-peptide, insulin, glucose blood:

Episodes B'("n‘:ii'l“;f)se Insulin (kE /1) C'pep:f:)e (ng/
1 1.2 20 _
2 2.1 302 0.014
3 2.8 63 0.26

In the clinical analysis of blood: Hb 123 g / L Erythrocytes 4,0nh1012 / |,
leukocytes 9,9n109 / L, platelets 325h109 / L ESR 44 mm / h.,

In biochemical analysis a blood protein: 69 g / I, cholesterol 4.21 mmol / |,
creatinine 73 umol / L, ALT 31 units / liter AST 35 units / L, HbAlc 8,8%. Blood
Electrolytes: K + 4.5 mmol / I, Na + 140 mmol / I, CI- 107 mmol / |

Urinalysis: sp. 1025 weight, pH 6, glucose Neg., ketones Neg., 0 erythrocytes,
leukocytes 5-6 in p / sp.

Glycemic profile:

Blood glucose (mmol / L)
Day Before Before lunch 2 hours Before
breakfast after lunch bedtime
1 4,5 1,2 2,6 3,3
2 1,0 - 2,0 4,9
3 - - - 14,4
4 24,5 2,8 - 1,9




5 1,6 1,9 3,1 5,0
6 18 6,8 8,4 6,1
7 . 3,9 4,6 4,1
8 11,1 4,0 16,0 12,0

8. Independent work of students:
According to the textbook, BA Korbinskogo "Medical Informatics” Glavul0
study "Automated information system of medical institutions"

9. Hronokarta training session:

1. Organizing the time - 5 minutes.
2. Monitoring of knowledge - 30 min.
3. Analysis of the theme - 20 min.
4. Practical work - 30 minutes.
5. Wrap-up sessions - 10 min.

10. A list of textbooks for the class:
1. Korbinsky BA / TW. Zarubin Medical Informatics. -. 2 nd ed. - M .:
Publishing Center "Academy", 2012. -192 p.
2. Esaulenko IE, Semenov SN Basics of practical informatics in medicine; VVoronezh
2005



